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Chapter1
Creating Charts

Charts communicate overall trends quickly with eye-catching and intuitive graphics.
Charts come in many different varieties that allow you to communicate information with
varying degrees of complexity and specificity. You can use simple charts to effectively
communicate simple metrics, and more complex charts to clearly display relationships
between different aspects of your data, making it easy to identify less obvious trends.

Different chart types utilize different kinds of data and enable different styling options.
You can easily change chart types by selecting a different option from the Content picker,
making it easy to ensure that you choose the chart type that best represents your data.

When creating your visualization, you can use tooltips and on-chart filtering to get the
necessary information from your chart, and you can also enhance the chart with run-time
capabilities such as drill-downs and In-Document Analytics to make even more
information available from a single chart.

In this chapter:

Displaying Measure Values in Charts

Formatting Charts

Creating Maps to Illustrate Trends

Using Your Extension in a Request

Configuring Automatic Refresh

Displaying Measure Values in Charts

In most chart types, measure values for different categories are communicated based on
visual cues. For example, the height of a riser in a bar chart, the size of a slice in a pie chart,
or the color or an area of a heatmap all communicate the measure value of the dimension
value that they represent. By comparing different areas of the chart, and by using the legend
and tooltips, you can quickly identify overall trends in your data.
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To display measure values in a chart, you add them to a measure bucket. The names of these
buckets differ, depending on the type of chart, and many chart types include multiple measure
buckets, so you can evaluate the relationships between different metrics. For example, in a bar
chart, you can display measure values using the Vertical, Size, and Color buckets. The Vertical
bucket expresses values of the selected measure field using the height of each bar, the Size
bucket expresses values using the width of each bar, and the Color bucket expresses values
using the color of each bar, based on a color scale. The Color bucket can accept either a
measure field or a dimension field. If you use a dimension instead of a measure, the color of
each bar or bar segment is based on dimensional series values.

Each chart type has a default measure bucket. When you double-click a measure field or drag
it onto the canvas, it is automatically added to that bucket. In the case of a bar chart, the
default measure bucket is the Vertical bucket. For more information about the buckets
available for each chart type, see the topics under Creating Charts.

By default, when a measure field is added to a measure bucket, the values are aggregated as
a sum. The aggregation is performed for each dimensional sort value. To change the type of
aggregation for a single field from sum to another option, such as count or average, right-click
the measure field and point to Aggregate. A list of available aggregation options displays. For
more information about aggregations, see Using Prefix Operator Aggregation Functions.

Alternatively, you can change the evaluation of all measure fields in your chart at once. From

the Calculation Options menu , you can change the evaluation in all measure buckets
from a summary aggregation to a count aggregation or to detail values, in which case measure
values are not aggregated at all, instead displaying the value of each record in your data set.
When you select one of these options, the icon displays above the chart buckets.

Displaying Measure Values in Charts
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The count evaluation method displays the number of records within each sort value. This
allows you to see the distribution of your data, such as in a histogram. To create a histogram,
create a new bar chart and create a set of bins for the measure field distribution you want to
evaluate. Add the newly created bins to the Horizontal bucket, then add the original,
associated measure field to the Vertical bucket. Finally, change the evaluation method from
Summaries to Counts. The chart now shows the number of records that fall into each bin
range, as shown in the following image.

When using the Counts evaluation option, you can still change the aggregation option for each
individual measure field, just like when you are using the Summaries option.

1. Creating Charts
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The Details evaluation option allows you to see the value of each individual record in your data
set. Since every record is displayed, the Details option is best used for chart types that can
display lots of values effectively. For example, the following image shows a scatter plot where
each point represents a different record. The Revenue and Cost of Goods values represented
by each axis are the non-aggregated revenue and cost of goods for each individual record.

If we had used the Summaries option, the chart would have displayed one point for each sort
value, as shown in the following image. In this example, the sort value was the dimension in
the Color bucket, Product Category.

Displaying Measure Values in Charts
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Note: If you are using a very large data source, you may wish to filter your chart before
displaying detail values in order to reduce the resources required to display all records.

Formatting Charts

Charts allow you to present information graphically, using such visual cues as color, size, and
position to convey relationships between measures (numeric fields to be aggregated) and
dimensions (categories) and to identify trends and outliers. You can create a wide variety of
charts. For example, you can review your data (Gross Profit and Product Category) using
different chart types (for example, bar chart, area chart, or line chart). The chart options give
you an edge in deciding which chart to use to highlight certain information or trends.

Once you have created a chart, you can apply various styling and formatting changes to it. For
example, bolding text in a legend or header, changing the color of a series, or changing the
appearance of axis lines. The chart formatting options allow you to specify how components
display, enabling you to format your chart to suit your needs.

The formatting capabilities of Db2 Web Query Designer let you indicate which aspects will
display, how fonts are utilized, and which additional options will enable you to create an
effective, styled chart. This allows you to control the display of your chart information, giving
you every opportunity to create a chart that you can share, distribute, and reuse on pages.

Customizing Charts

As you work with your chart, you can make modifications that improve the display of your chart,
highlighting the layout and presentation of the chart components. Some of the formatting
options include:

Controlling font display

Customizing headers and footers

Changing the format of your legend

Formatting the axes of your chart

Formatting the series of your chart

Customizing the format of your matrix chart

Enhancing a box plot

Enhancing your grid

Enhancing a gauge

Adding a theme

1. Creating Charts
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Adding color to your chart

You can access the formatting options from the Format tab, as shown in the following image.

General options display, by default, but you can use the Quick Access menu to select a
different aspect of your chart, for example, Legend, Axis, Series, or Matrix options, as shown in
the following image.

Different options are available, depending on the chart type.

Formatting Charts
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Once you select an area of your chart to modify (for example, Axis), you can use the intuitive
options and menus to make selections, as shown in the following image.

You can also access styling options by right-clicking an area of your chart, such as a riser or
axis label, and clicking Style.

Note: If you are working with a map, reference lines, or data grids, additional tabs will display,
enabling you to make formatting changes to these components. These tabs do not display, by
default.

1. Creating Charts
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By streamlining formatting options in one place, you can quickly format charts to enhance the
display of your data. Whether it be color-coding a series in a chart or changing the font size of
your data labels, a customized, formatted chart is just a click away.

Controlling Font Display in a Chart

You can use the font formatter in Db2 Web Query Designer to control how fonts are displayed
in your chart. This is a quick way to apply styling, colors, or a specific font type for any text
within your chart. The font formatter displays in different areas of the Format tab (for example,
Legend, Axis, Series, and Matrix options). Depending on the chart type and what you want to
format, you can use these options to enhance the fonts in your charts. The font formatter is
shown in the following image.

You can also change the font of a header or footer in your chart. This allows you to control how
a chart is labeled or highlighted, which is useful when the chart will be distributed. For headers
and footers, you can:

Change the font type and font size.

Add bold, italic, and underline emphasis to your text.

Set the justification of text in your header or footer. For example, left-aligned, centered, or
right-aligned.

Change the font color or background color.

The styling toolbar for header and footer text is available along the top of the canvas, as
shown in the following image.

When reviewing text that displays in your chart, you might want to increase the font size of the
header text to enhance its visibility. Editing the font types and styles in your chart gives you
more control over how information is displayed and presented.

Formatting Charts
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Procedure: How to Change the Font Type in Your Chart

Changing the type, size, and emphasis of a font improves the impact for the user that is
analyzing this chart. To change the font of a chart header:

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Add one or more measures and dimensions to your chart.

4. Double-click Chart Heading to enable it for formatting, and change this text to Discount by
Product Category.

The styling toolbar displays along the top of the screen, as shown in the following image.

5. Ensure that the header Discount by Product Category is selected or highlighted.

6. From the styling toolbar, change the font type to Cambria, size 24, Bold.

1. Creating Charts
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The revised chart header displays and reflects the new font type and styling, as shown in
the following image.

Note: You must select the text you want to modify in your header or footer before you
apply any changes to the font.

Adding Headings and Footings to a Chart

You can use headers and footers to add key information, such as the purpose of the chart and
the audience. For example, if you have gross profit for different product categories, you can
add a header to highlight this information in your chart.

You can add multiple lines of information into the heading and footing areas in a chart. This
accommodates thorough explanations and additional information while offering the most
readable presentation.

Formatting Charts
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You add a new line in the heading and footing by pressing the Enter key. The number of lines
of heading and footing you can add to a chart is only limited by the available real estate on the
chart. The chart body will adjust to fit within the available space with the heading/footing lines
inserted. You can change the font size or other presentation aspects using the editing toolbar
that displays. When you are finished editing the heading and footing and edit mode is closed,
the chart canvas adjusts to ensure that all lines of the heading or footing are visible, as shown
in the following image.

Headers and footers can contain the same type of information. Footers are not enabled, by
default, but can be enabled from the Content area on the Settings tab, as shown in the
following image.

1. Creating Charts
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You can make styling changes to the information in your headers and footers, which allows you
to interactively style the text according to your preferences. Using a WYSIWYG canvas, it
delivers formatting changes instantly, allowing you to see the results of your selections as you
make them. When editing your header or footer, you can find the options at the top of the
canvas, as shown in the following image.

You can change the font and font size using the drop-down lists. You can add bold, italic, and
underline accents to your text. In addition, you can change the positioning of your text (left,
center, and right). You can also customize the color of the text, as well as the background of
the header or footer text area. When your formatting is complete, you can close the toolbar
and continue working with your chart.

Note: You can double-click the heading or footing to resume modifications at any time.

Procedure: How to Add Headings and Footings to a Chart

You can add and style headings and footings in a chart.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Add one or more measures and dimensions.

4. On the Settings tab, expand the Content area and select Enable footing.

Formatting Charts
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The headers and footers display, as shown in the following image.

5. Double-click the heading and change it to Sales by Category.

The styling options to edit the header and footer text are shown in the following image.

6. Change the font color to grey and change the font size to 20, as shown in the following
image.

1. Creating Charts
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7. Change the footer to read October, 2019.

8. Change the font size to 8 and right-justify it, as shown in the following image.

Formatting Charts
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Using headers and footers, you can add the finishing touches on your charts, identifying
them with useful information for your audience. For example, when sharing and distributing
your charts, headers and footers can help identify and streamline your communication.

Formatting Legends in a Chart

In a chart, the legend identifies values according to the color-coded data values that display.
The legend typically displays on the right side of the chart, but you can change the location
using the formatting options. You can format a legend in any of the following ways:

Turn the Legend On, Off, or set it to Auto.

Change the font features of the legend (for example, bold or a larger font size).

Change the format of the title of the legend.

Access options to change background options, including setting the background color and
setting the border line width, size, and color.

Set the display options for the legend.

1. Creating Charts
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To access the legend formatting options, click the Format tab. From the quick access list at
the top of the tab, select Legend. The Legend formatting options display in the following
image.

Use the On, Off, and Auto buttons to control how the Legend appears on your chart. You can
optionally select On or Off, depending on whether you want to display the legend in your chart.
The legend display setting is set to Auto, by default, which displays the legend only if there are
multiple series in the chart.

Formatting Charts
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Note: Occasionally, charts are large and require additional real estate. Hiding the legend, or
turning it off, enables you to preserve additional room as required by the chart.

Under Labels, you can format the font used for the label text in your legend. These options
include Font type, Style, Size, and Color.

Depending on the type of chart you use, adding data to a specific field automatically generates
a title for the chart legend. For example, the following image displays a matrix marker chart
that allows you to compare the differences between values by circle size. Since the measure
Gross Profit has been added to the Size bucket, the legend title for this chart shows as Gross
Profit, which is highlighted in the following image.

Under Titles on the Format tab, you can choose to show or hide the legend title with the Show
Titles check box. You can also choose the font style and formatting of the legend title.

Under Other on the Format tab, you can perform tasks such as changing the position, setting
the background color, and setting the border line width, size, and color. You also have options
to display the legend options in reverse order and set it as collapsible.

1. Creating Charts
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Using Axis Options in a Chart

Depending on the chart type (for example, bar chart), you can format the axes to customize the
display of the information. This includes items such as labels, titles, and font formatting. For
example, you can choose to hide the labels in your chart or format the font to add clarity to
your chart. You can easily customize the X and Y axis with options that suit your needs. To
access these options, select Axis from the quick access menu on the Format tab. Other
options, such as dual-axis, bi-polar axis, and split axis behavior, and a continuous time axis,
are available by right-clicking a field once it has been added to your chart or using the menu
next to the Vertical bucket.

Formatting Charts
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You can rotate the labels in your axes as well as stagger them. This allows you to shift the
display of information, which is particularly useful when your chart is very dense. You can
modify the lines for individual axes, enhancing the frame of the axis on the chart. You can also
show ticks, which allows you to view milestones in your data. You can also change the position
of an axis, enabling you to dictate where your axis information will display (for example, right).
The options on the Format tab for formatting an axis are shown in the following image.

1. Creating Charts
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In bar, line, and area charts, you can control x axis scrolling behavior from the Scroll menu. By
default, the Scroll option is set to On and the scrollbar is enabled. When a large number of
values are displayed on the x axis, a scrollbar generates so that they all have enough space to
fit comfortably in the visible area of the chart. To disable the scrollbar, set the Scroll option to
Off. When the scrollbar is not enabled, points and labels are compressed to fill the area
occupied by the chart. As an alternative to the basic scrollbar, set the Scroll option to
MiniChart. Instead of using a basic, default scrollbar setting, the minichart option provides a
simplified image of the chart, with a transparent scrollbar, as shown in the following image.

You can point to the edge of the minichart scrollbar and use the double-headed arrow cursor to
change the visible area of the chart by expanding or contracting the scrollbar. To set the
default minichart scrollbar size, use the Count property that appears on the Format tab when
you select the MiniChart option. The count represents the number of values initially visible on
the x axis. For example, the default Count value of 10 means that a maximum of 10 values
display in the chart at all times, regardless of the physical width of the chart area.

Formatting Charts
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In bar, line, and area charts, you can also choose whether the y axis, or vertical axis, should
be shared between all measures, or split so that each measure is separated and generates
separate bars, lines, or areas. By default, the axis is blended, so all measures share the same
y axis. To split the y axis, on the Settings tab, click the menu next to the Vertical bucket (or
Horizontal bucket if the axes have been swapped), and click Split axis, as shown in the
following image.

This option is especially useful if there are large disparities between the values of different
measure fields. For example, the revenue values in a data source may be many times greater
than the quantity sold values. To merge the axes back together, click the same menu, and
then click Blended axis.

Alternatively, if you want to split the measure fields in a bar, line, or area chart into groups on
separate axes, you can use the bi-polar axis option. The bi-polar axis option creates a second
set of axes to which you can add some of your measure fields, instead of splitting each
measure onto a separate axis. To enable this option, click the menu next to the Vertical bucket
and then click Bi-Polar axis. To switch the y-axis that a measure field uses in bi-polar axis

mode, click the axis icon  next to the field in the measure bucket, or right-click a measure
field and click Top Axis (Y1) or Bottom Axis (Y2).

1. Creating Charts
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When creating a bi-polar axis chart, it may be useful to change the chart type of the risers for
one of the measures on an axis to differentiate it. Right-click the measure field in the Vertical
bucket (or the Horizontal bucket if the axes have been swapped), point to Shape, and choose
whether the chart type for that measure should be bar, line, or area. The following image
shows a bi-polar axis chart in which the Cost of Goods field is represented by a line chart.

Another way to show multiple measure fields on separate axes is to use dual axes. Instead of
splitting the chart into horizontal sections, one or more measure field is plotted against the y1
axis on the left, and the other uses the y2 axis on the right. To specify which axis a measure

field should use, when the Blended axis option is selected, click the axis icon  next to the
field in the measure bucket, or right-click the field and click Left Axis (Y1) or Right Axis (Y2).
Each of these axes can be styled separately from the Axis options on the Format tab. When
using dual axes, take note of which axis is used for each measure, as the values displayed in
the chart may visually appear to be closer than they are in reality.

The same options are available for horizontal bar, area, and line charts, but affect the x axis,
or horizontal axis, instead.

Formatting Charts

26 



Procedure: How to Format Axes

You can format the axes of your chart to customize the display of information, including labels
(rotated and staggered), titles, and axis-specific fonts.

1. Create a chart using Db2 Web Query Designer, or open an existing Db2 Web Query
Designer chart.

Axes are used in bar, line, area, scatter, bubble, and circle plot charts.

2. On the Format tab, click General to open the quick access menu, and then click Axis.

The options for editing your axes display.

You can select the Y-axis or edit the X-axis. The axis selection determines where changes
are applied.

3. On the X-axis, perform the following formatting tasks:

a. In the Labels section, change the font format of the labels to bold.

b. Expand the Title section and change the size of the font for the axis title to 16.
Change this to bold as well.

4. Select the Y-axis option and perform the following formatting tasks:

a. Change the font format of the label to italic.

b. Change the size of the font for the Title to 16. Change this to bold as well.

When you preview the chart, you can see that styling on the axes has been modified,
giving you a custom look and feel for your chart, as shown in the following image.

5. You can rotate the labels on the X-axis. In the Labels group, use the Rotation option to
rotate the labels by 45 degrees, as shown in the following image.

1. Creating Charts
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6. You can also modify the line size of the axes. In the Lines group, use the Axis lines option
to change the line size for both axes to 5. Making the axes lines bigger creates a more
definitive frame, as shown in the following image.

With the axes of your chart formatted, you can continue making modifications or apply
similar formatting to the axes in other chart types.

Controlling the Display of Time-Based Axes

By default, when you create a chart that has a dimension on an axis, missing values are not
displayed on that axis. For example, if you create a bar chart showing revenue by product
category, but there are no revenue values, including zero, for televisions, then televisions will
not appear on the horizontal axis in the bar chart.

However, when you create a line or area chart using a date or date-time field as one of the
axes, this is not the case. In these chart types, when a date or date-time field is used, the
time axis option is enabled by default. This option allows you to show the entire, continuous
range of time encompassed by your data, even if there are missing values in between. Missing
values are extrapolated based on the nearest values. The time axis option allows you to see
changes in your data over time on a continuous scale, displaying date values more intuitively
and making it easier to recognize gaps in your data.

Formatting Charts
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When the time axis option is enabled, the values in the chart are plotted along a continuous
date axis, as shown in the following image.

Although there were no sales between December 6 and December 20 in the image shown
above, those days occupy the same amount of space on the x-axis as the days in which there
were sales, and the line is extrapolated for them. The same chart with the time axis option
disabled is shown in the following image. Only dates with values in the data set of the chart
display. Since not all dates appear in the chart, each existing date value is labeled on the axis.

1. Creating Charts
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To disable the time axis option and show only the date values in your data source, right-click
the date or date-time field in the Horizontal or Vertical bucket of your chart and deselect Time
axis, as shown in the following image.

To re-enable the time axis option, right-click the date or date-time field and click Time axis
again.

Formatting Charts
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Formatting Series in a Chart

A series represents a set of related values in a chart. These could be different measure fields
in a chart, or different dimension field values in a chart. You can format all series together, or
format each separately, including color, shape, display options for labels, and other options,
including the ability to hide overlapping labels. You can select a specific series in a chart to
which to apply changes, or you can select All Series, which applies changes to all series in the
chart.

Having the ability to format by series gives you control over your content and allows you to
customize display options at the series level. For example, you might want to color code a
chart based on a range of values. You can also specify options for the data labels of the
series. By default, these are enabled or hidden automatically depending on the chart type, but
can be turned on or off. You also have the standard suite of font options, as shown in the
following image.
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Different kinds of charts allow you to make different series-level style changes. For example, in
a bar, area, or line chart you can set the width of all bars, or change a series to display as a
line or area instead of a bar or bar segment. In a ring pie chart, you can change the size of the
hole in the middle when viewing the options for all series, and on a scatter plot or bar, area, or
line chart, you can add and style a trend line with different formulas for all series or an
individual series. Other chart types allow different styling changes.

Additionally, some series styling options are only available when modifying all series in a chart,
or only available when editing a single series. For example, when creating a bar chart, you can
set the bar width for all series, but not for a single series. On the other hand, you can change
the fill color for a single series, but not for all series in the chart.
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When working with series in a chart, you can also set an option to control the display of data
labels in your chart. The default is Auto. This gives you the ability to specify how your data will
be presented (for example, by Value or Percentage), which is particularly useful in cases where
you want to save real estate when using data labels in your chart, or show additional
information. You can click the drop down to access a full list of content options, as shown in
the following image.

You can use the following terms to decide the best way to display the content of your data
labels.

Auto. The chart engine decides what data label information to show. This is usually the
value.

Label. Shows the series label of the riser, marker, or slice (same as legend label)
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Value. Shows the value of the riser, marker, or slice, using the numeric format of the field.
For example, if the field defined in the master file is US Currency with two decimal places of
precision, then that is what the dataLabel will be ($123.45).

Percentage. Shows the percentage of the riser/slice based on the group to which it
belongs.

Value,Percentage. Shows the value of the riser, marker, or slice, with numeric formatting
and the percentage of the riser/slice based on the group to which it belongs.

Label,Value. Shows the series label of the riser, marker, or slice (same as legend label)
and the value of the riser, marker, or slice, with numeric formatting.

Label,Percentage. Shows the series label of the riser, marker, or slice (same as legend
label) and the percentage of the riser/slice based on the group to which it belongs.

Label,Value,Percentage. Shows the series label of the riser, marker, or slice (same as
legend label), as well as the value of the riser, marker, or slice, with numeric formatting. It
also shows the percentage of the riser/slice based on the group to which it belongs.

When creating a stacked bar, stacked area, or stacked line chart, you can also select the
Show stacked totals option to show the summed total of all series at the top of each bar or
sort-value point.

You can also Wrap Data labels, which allows you to truncate available chart space or show
your data on multiple lines. The following examples show how the wrapping option works.

Example of WrapDataLabel=True:

"France

$123.4

23.4%"

Example of WrapDataLabel=False:

"France, $123.4, 23.4%"
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Specifically, the data label options allow you to determine what is shown when Show label is
ON. For example, Label,Value,Percentage. If the option is set to Auto, the chart engine decides
what it thinks is the best content to show. Typically, this is the value of the riser or slice. For
example, on a basic pie chart, the Auto setting produces the following result.

You have additional content choices. For example, you can choose Label, which corresponds
to the series label that is shown in the legend. When you select the Label option, you also
have the option of turning the legend off, so as not to duplicate the information that is
displaying in your chart. The Label option is shown in the following image.
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You can also choose Percent, which shows the percentage of the whole for each riser or slice.
This is very useful for a pie or stacked bar chart, as these are the charts that are best used to
visualize the concept of percentage-related content, as shown in the following image.

You can also display the Value, which is the riser/slice value. This is often the same thing you
will get if you choose Auto.
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There are also options for you to combine three choices, such as Value, Label, and Percent.
This allows you to display all three items, as shown in the following image.

Click Wrap Data labels to display the content on three separate, unique lines, or clear the Wrap
Data labels check box to display all label information on a single line.

Procedure: How to Format a Series

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Create a Vertical Stacked Area chart.
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4. Add a measure to the Vertical bucket, a dimension (for example, a time based dimension
with month or year values) to the Horizontal bucket, and another dimension to the Color
bucket, as shown in the following image.

5. On the Format tab, open the quick access menu and then click Series.

6. In the Data labels section, in the Show label group, turn data labels on by changing the
setting from Automatic to On.

Since All series is selected by default, labels are displayed for every series in your chart.

7. Format the labels with 10 point, red font using the font options.
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The values in the chart reflect your custom formatting, giving you a better view of your
data, as shown in the following image.

8. Change the color of one of the risers.

a. From the series selection drop-down menu, on the Format tab, directly below the quick
access menu, select a single series. Each series represents a value from the field in
the Color bucket.

If your chart contains multiple measure fields, then each series represents a measure
field in addition to or instead of a dimension value.

b. In the Shape section, change the color selected for the Fill option to a color of your
choice.
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The selected series riser updates to show the new color, as shown in the following image.
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Formatting Matrix Charts

If you are working with a chart type that supports a matrix format (for example, Matrix Marker,
or another chart type utilizing matrix rows and columns), Db2 Web Query Designer provides a
selection of formatting options that you can use to customize and enhance the styling of your
chart. A matrix format is a grid that contains values based on the intersecting data points,
which is useful for reviewing changes and trends over time. Available formatting options for
matrix charts include Headers and labels, and Lines, as shown in the following image.

You can customize the row and column headers and their corresponding values in a matrix
chart. Specifically, you can change the font type, font size, and color. You can also change the
emphasis of the font using bold or italic styling. You can also change the alignment of row
values text.

When working with lines in your matrix chart, you can change the line style (for example, solid
or dotted) and the thickness. These formatting options allow you to make visible
enhancements that will improve the appearance and presentation of your matrix charts.
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Procedure: How to Format a Matrix Chart

To format a matrix chart:

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. From the Content picker, select the Matrix Marker chart type.

4. Add two dimensions and two measures to the chart. These data fields should be placed in
the Vertical, Horizontal, Size, and Color buckets.

5. On the Format tab, click General and then click Matrix options from the drop-down list.

6. Apply formatting changes for the matrix chart, including:

a. Headers and labels, which allow you to customize the font options for row and column
headers and values. Font options include font type, bold, italic, font size, and font
color.

b. Line style, which allows you to adjust the type, size, and color of the lines for the
matrix chart.

7. Change the font being used for row and column headers to bold, red, and size 16 font.

The updated matrix chart now displays customized row and column headers, as shown in
the following image.
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8. Using the options in the Lines section, change the line style to blue, dashed lines.

The resulting matrix marker chart resembles the one shown in the following image.

Formatting Box Plots

A box plot is a common chart type used to show key distribution information for a set of data
points. A box plot displays outliers, the median, the upper and lower quartile, and the
maximum and minimum with outliers excluded, by default. However, you can use the Box Plot
options on the Format tab to show the mean, or average, as well. Additionally, you can change
the display of the whiskers from lines to boxes, and change the style of the median and
whisker lines.

To access the Box Plot properties when creating a box plot, click the Format tab and select Box
Plot options from the Quick Access menu. The following options are available:

Show Mean. Displays a marker at the mean point, which you can compare with the median
to get an idea of the skewness of your data.
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An example of a box plot with mean markers enabled is shown in the following image.

Show Hat as Box. Changes the appearance of the whiskers in the box plot from lines to
boxes.

An example of a box plot with the Show Hat as Box option enabled is shown in the following
image.
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Line style. You can change the pattern of the median and whisker lines from a solid line to
a dotted or dashed line, and change the width and color of the lines.

Procedure: How to Format a Box Plot

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. From the Content picker, select the Statistical Boxplot chart type.

4. Add a measure to the Vertical bucket and a dimension to the Horizontal bucket.

A single measure value displays as a line in each column.

5. Use one of the following methods to generate a set of data for each column:

Add a dimension field to the Detail bucket. This field should provide multiple records
for Horizontal bucket value.

Change the calculation option from Summaries to Details . If you have a very large
data source, this may generate too many records to evaluate in the box plot.

A set of box plots appears on the canvas, showing indicators for outliers, maximum and
minimum, median, and upper and lower quartiles.

1. Creating Charts

Creating Charts  45



6. On the Format tab, click General and select Box Plot options from the quick access menu.

7. Optionally, select the Show Mean check box to display a marker in each box plot indicating
the location of the mean.

8. Optionally, select the Show Hat as Box check box to display the whiskers as narrow boxes
on either side of the box showing the interquartile range.

9. Optionally, change the style of the median lines and whisker lines.

Click the box showing an image of the line to change the line pattern to one of a variety of
dashed and dotted lines. Use the spinner to change the width of the lines, in pixels. Click
the color swatch to change the color of the lines.

The box plot updates on the canvas as you make your changes.

10. Once you finish creating and formatting your box plot, save it, or convert it to a page to
develop more content.

Formatting Data Grid Charts

A data grid is a type of chart that displays a tabular representation of your data, similar in
structure to a tabular report. A data grid allows you to review data in a row and column format,
similar to a printed report. Data grids are easy to create, and provide features such as a tooltip
for each cell of the grid. Db2 Web Query Designer provides numerous options to style and
format a data grid.
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Values in a data grid can be sorted, and data grids can be shared or saved for use on a page.
A data grid is shown in the following image.

You can format a data grid using the options on the Format tab. The Format tab contains two
sets of options, General and Datagrid options, which you can access using the quick access
menu, as shown in the following image.

The General section provides a set of options that are common to all chart types. These
options are divided into three sections: Theme, Frame and background, and Other.

The Theme section provides a menu that allows you to select a StyleSheet to automatically
format the data grid. You can select from a list of themes available with Db2 Web Query, or
click Custom to select a StyleSheet from the legacy templates or your repository.
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The Frame and background section includes the following options:

Background. Allows you to select a color for the background area behind the data grid.

Frame. Allows you to select a color for the chart frame. This option allows you to change
the data cell fill color in the data grid.

Frame Border. The Frame Border settings are not applied to data grids. To style the
borders in the data grid, use the Border style settings under Headers and values in
Datagrid options.

The Other section includes the following options:

Fit to container. This option does not apply to data grids. It is used for bar, line, area, and
scatter plot chart types.

Hide null groups. When selected, if any rows or columns in the grid do not contain any
data, they are hidden at run time.

Show null as zeroes. When selected, cells for which no data is returned show a value of
zero (0). When not selected, cells with no data appear blank, which is the default.

You can also select styling options that are specific to data grids. These are listed when
Datagrid options is selected from the quick access menu on the Format tab. You can also
access these options by right-clicking an area of the data grid and clicking Style.

The Datagrid options are divided into three sections: Headers and values, Background and
padding, and Other.

The Headers and values section allows you to define the styling properties of the item selected
from the Headers and values menu. You can set these properties for the row headers, column
headers, cell values, and column totals. The Headers and values section contains the
following options for each area of the data grid.

Format. Allows you to select the font, text formatting, font size and units, and text color.

Alignment. Allows you to set the text alignment to the left, center, or right side of the cells.

Border style. Allows you select the line style (for example, solid, dashed, or dotted),
thickness, and color of the cell borders.

The Background and padding section allows you to style the cells in the data grid by adding
bands and increasing the cell padding. Options in this section include the following:

Row color. Allows you to add bands to the data grid to make the rows easier to distinguish.
Select the Alternate row color check box to add alternating bands to the data grid and
select a color from the Color picker to style them.
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Vertical padding. Allows you to set the vertical padding, in pixels, between the text and
borders of each cell.

Horizontal padding. Allows you to set the horizontal padding, in pixels, between the text
and borders of each cell.

The Other section allows you to add column totals to the data grid and freeze column and row
headers. The options in this section are as follows:

Show column total. When selected, adds a column total row to the data grid. This row can
be styled by selecting Totals in the Headers and values section. Show column total is not
selected, by default.

Freeze column headers. When the data grid uses a vertical scrollbar, selecting Freeze
column headers keeps the column headers in place while scrolling so that you can see
which column each cell belongs to. When not selected, the column headers are not frozen
when scrolling. Column headers are frozen, by default.

Freeze row headers. When the data grid uses a horizontal scrollbar, selecting Freeze row
headers keeps the row headers in place while scrolling so that you can see which row each
cell belongs to. When deselected, the row headers are not frozen when scrolling. Row
headers are frozen by default.

Fit to container width. When this check box is selected, the grid spans the entire width of
its container. When this check box is not selected, the grid width is only as wide as is
needed to show each column header fully.

Procedure: How to Format a Data Grid

You use the options on the Format tab to customize a data grid. These options allow you to
style the data grid to match your preferences while maintaining the simplicity and clarity of the
data grid chart format.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. From the Content picker, select the data grid chart type .
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4. Add fields to the data grid.

a. In the Resources panel, with Fields selected from the sidebar, in the Dimensions area,
expand Product and drag Product,Category to the Row field container.

b. In the Measures area, expand Sales and drag Cost of Goods and Revenue to the
Measure field container.

c. In the Dimensions area, expand Customer and drag Customer,Business,Region to the
Column field container.

A basic data grid has been created, showing Cost of Goods and Revenue sorted by
Product Category across Customer Business Region.

5. Add a header to the grid.

a. Double-click the Chart Heading text.

The text is highlighted and Rich Text Editor displays.

b. Type Regional Sales into the chart heading area and click the X on the styling toolbar.

The chart header is changed to Regional Sales.

6. Open the Format tab.

7. Change the background color of the cells to seafoam green.

a. In the Frame and background section of the Format tab, click the color sample under
Frame.

The color picker opens.

b. Click More to access the color wheel. Select seafoam green by clicking on the wheel
in a location between cyan and green, and then using the brightness slider to select a
light seafoam green color. Alternatively, type a hex code value into the text box. For
example, #adebcc.

c. Click OK.

The data cells in the data grid now have a seafoam green fill.

8. Access additional styling options for the data grid. Open the quick access menu and select
Datagrid options.

9. Make the across column headers bold.

a. From the Headers and values drop-down menu, select Column headers.

b. Click the Bold button to make the text bold.

10. Add pink bands to the grid.

a. Expand the Background and padding section.

b. Select the Alternate row color check box.
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The rows now alternate between the seafoam green background and the default gray
bands.

c. Click the color sample under the Alternate row color check box.

The color picker opens.

d. Select the pink color from the palette.

Now the data grid shows alternating seafoam green and pink rows.

11. Add column totals to the grid.

a. Expand the Other section.

b. Select the Show column total check box.

The column total row appears on the data grid.

12. Style the column row total by changing the text and border color to purple.

a. From the Headers and values drop-down menu, select Totals.

b. In the Format subsection, click the color sample to change the text color for the
column totals.

c. Click More to access the color wheel, then select a shade of purple.

d. Click OK.

The column totals now show in purple text.

e. Add a purple border to the columns total row.

In the Border style subsection, click the color sample to open the color picker. From
the Custom Colors palette, select the same purple color that you used for the text.
This color was automatically saved and added to the Custom Colors palette.

f. Click OK.

The text and border for the column totals now use the same shade of purple.

An example of what the resulting grid may look like is shown in the following image.
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Customizing a Gauge Chart

A gauge is a simple chart that allows you to display basic KPI values. You can choose to
display these values with a standard or simplified dial graphic, or alone, as text only. The
default, simple, gauge type is shown in the following image.

You can change the gauge type from the display options, above the buckets on the Settings
tab. Use the default, Simple option to show a simple gauge dial, use the Circular option to
show a gauge dial with a pointer and tick marks, or use the KPI option to show text only.

When you create a gauge, the Gauge Properties option becomes available on the Format tab.
You can change the following properties of the gauge label and value text:

Label

Show label. Select this check box to show the name of the measure field represented
by the gauge. This text only displays when using the Circular or KPI display options. For
example, the following image shows a KPI gauge with the label position set to Top.

The following image shows a KPI gauge with the label position set to Bottom.

Position. You can choose to place the measure label above or below a circular or KPI
gauge.

Font. Change the typeface, font style, size, and color of the label text as it displays in a
circular or KPI gauge.

Value

Show value. When creating a circular gauge, select this check box to show the gauge
value as text, or clear it to hide the text and only show the value graphically. The simple
and KPI gauge types always show the value text.
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Font. Change the typeface, font style, size, and color of the value text as it displays in
the gauge. When using the simple gauge type, you can also leave the Enable font
autosize check box selected to have the value text automatically resize to fill the inside
of the gauge, or clear the Enable font autosize check box to set a consistent font size
for the value text.

Adding a Theme to a Chart

A theme is used to determine the coloring and hues that display in the charts you configure
using Db2 Web Query Designer. For example, the default border color and chart colors are
determined by the theme.

When creating stand-alone content, the default theme is Designer 2018. When you turn the
visualization into a page by adding a second new content item, the theme used for the chart is
applied to the page. When you add items to the page, either by creating them or adding them
as external content, the page theme is used as the default for all content items. You can then
change the theme for each individual item.

You can use one of the themes included with Db2 Web Query, or you can create your own
theme. For example, you may want to apply a corporate standard theme to your chart. You can
add and change themes to suit your requirements (for example, branding).
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Available themes that are called by Db2 Web Query Designer are located in the Themes folder
in the Global Resources area, accessible from the Workspaces tab of the Db2 Web Query Hub
or Home Page, as shown in the following image. Custom themes can be added to folders
within the Custom folder.

Supported formats for themes include .css and .sty. A .css theme file is used to style a page,
while .sty file is used to style content such as charts and reports. When files called theme.css
and theme.sty are placed into the same folder in the custom themes folder of the Global
Resources area, they are available for selection in Db2 Web Query when editing page
components and content items. The two files are associated, so when the .css theme file is
applied to a page, the associated .sty theme file is applied to new content in that page, by
default. Similarly, if you select a theme for a chart, which uses the .sty file, then when you
convert to a page, the associated .css file is used as the default page theme.

You can develop your own theme using the Db2 Web Query text editor and then access it in
Db2 Web Query Designer. You can customize the .sty theme file used for charts and reports by
specifying a set of default property values in it.

Tip: You can use the code from an existing theme as a model when creating a new theme.
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Note: Charts and reports created for use on pages can use a transparent background to allow
the defined background color of the page containers to show through. Since the themes used
for charts and reports (.sty files) can be associated with themes for pages (.css files), you can
coordinate the background, text, and element colors used in both themes to create content
with unified styling. At design time, the page theme associated with the chart or report theme
is used for the canvas background. This is for visibility purposes only, and shows how the chart
or report will appear when added to a page with the associated theme. The stand-alone chart
or report does not include this background.

If a chart or report is run stand-alone instead of being added to a page, the run-time view
displays a white background only. This means that if, in order to display on a dark colored
page, the font color in the selected theme is defined as white and uses a transparent chart
background, then the text will not be visible on the white preview background. An example of
such a theme is the Midnight theme, provided as one of the default themes in the Global
Resources. To view the white text, build your chart or report on the canvas, add it to a page
container with a dark background, or change the chart background color from the Format tab.
Note that a non-transparent chart background is layered in front of the panel background when
the chart is part of a page.

Procedure: How to Add a Theme to a Chart

You can add a theme to a chart to color the background and components of your chart. If the
chart is in a page, the default theme is the one used in the page. If the content is stand-alone,
so that there is no page from which to inherit the theme, the default theme is called Designer
2018.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.
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If you start creating content without changing the theme, the default theme is used, as
shown in the following image.

3. On the Format tab, with the General option selected from the quick access menu, in the
Theme and Format section, open the Theme drop-down menu.
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A list of available themes is displayed. As shown in the following image, you can choose
from the Designer 2018, Light, Midnight, and Vivid themes that are included with Db2 Web
Query, a custom theme added to the Global Resources area, such as the themes Alex's
Theme, Custom Theme, or MyTheme shown in the image, or click Custom to select a
legacy theme or a theme saved to a workspace folder.

4. Select another theme from the list (for example, Light) to change the theme.
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The color of the background and chart components changes based on the selected theme,
as shown in the following image.

5. Click Convert to page on the Visualization toolbar to transform the chart into a page and
move it into a container.

The visualization transforms from a single content item into a page. Notice that the page
adopts the theme that was used for the original content item. Additionally, the content
item now has a theme of Inherit Page Theme, so that if you change the theme of the page,
the theme of the content item changes along with it.

6. Add fields to the new chart to create a second content item. Notice that it also initially
uses the same theme as the page.

7. Click the page toolbar or select the Visualization item from the outline to select the entire
visualization.

8. Click the Format tab select a different theme from the Theme drop-down menu, for
example, Midnight.

Notice that the theme of both content items have also changed to match the page, since
they have a theme setting of Inherit Page Theme.

9. Select one of the items on the page and, on the Format tab, with the General area
selected, change the theme.
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The content item whose theme you explicitly set has changed, while the second item, for
which a theme was not explicitly selected, still uses the theme used for the page, as
shown in the following image.

Adding Colors to Charts

By adding color to your chart components, you can change the way information is perceived
and plays a large role in the effectiveness of your chart.

Color adds contrast to your charts, giving you an advantage in presenting unique, well-balanced
content. You can use color to highlight a specific aspect or outcome on your chart. Db2 Web
Query Designer provides a color picker to add color and style your chart.

You can access the color picker in two primary ways: on the Format tab and at the top of the
canvas when formatting headers and footers. Using these options, you can change the color of
different components to style your chart. You can indicate color values and ranges to highlight
data. You can color a chart component (for example, a header or axis), text, or even add
colored lines to accentuate the background grid of your data. You can also change the theme,
which changes the color palette and background of your chart.
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The following image shows an example of color options that display on the Format tab (with the
palette exposed), which you will also see in other areas where color formatting is supported:

The following image shows the options that display at the top of the canvas (with the palette
exposed) when working with headers and footers.
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Note: When specifying a theme, you can use the default or specify another one. The colors
stored for the theme are part of the underlying .css or .sty file, which contains the color
schemes.

In Db2 Web Query Designer, the color picker supports a colorspace and a palette-based
approach, as shown in the following image.

You can access the color picker from any of the sections on the Format tab. You can also
access the color picker when working with headers and footers. When you access the color
picker, the color picker displays the Palette tab, by default. From this tab, you can select from
up to 20 pre-defined color options. You can also select the No Fill option, which displays the
selected content as transparent. This is particularly useful in cases where you might want to
prevent (or hide) the display of information.

The More tab allows you to choose a custom color by interacting with a hue wheel and the
color value field, as shown in the following image.
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You can specify an exact color code (hexadecimal or HTML) by entering it in the color value
field located at the top of this tab, and also specify transparency by using the transparency
slider.

Note: When a custom color is selected and you click OK, the color is automatically added to
the Custom Colors section in the Palette tab.

You can also set a color range for a measure in your chart. This allows you to specify hues or
ranges of color for use in your chart. In cases where Theme is not selected, the color
specification overrides what is available in the theme. The color that you select dictates the
legend, which in turn displays the various chart components, based on the colors and
measurements specified.

To change the color scale options, right-click a measure in the Color bucket and select Set
color ranges, as shown in the following image.
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This invokes a new dialog box, Set Color Ranges, where you can select a color range for your
chart, as shown in the following image.

When you make a selection, you can override the color schemes that are available from the
theme of your chart. Theme is selected, by default. You can select a different color range, such
as Green or Red/Orange, from the list of options, which gives you more control over how color
is used in your chart to create contrasts between various aspects. For example, if your chart
displays different temperature values using a measure in the Color bucket, you may wish to
use the Red/White/Blue option to intuitively show higher temperature values in red and lower
ones in blue

If you change the color range to something other than Theme, it is written as inline styling in
the .fex file. Inline styling always overrides what is in the StyleSheet because it is listed after it
in the .fex file. In this case, the last setting indicates which styling takes precedence. When
the color range is set back to Theme, the inline styling is removed so the behavior returns to
the theme's settings.

This behavior does not affect your ability to change themes on the Format tab. However, if you
change the theme with an inline setting in place, the settings of the Theme will still be
overridden by the inline settings and the color scale in the legend will not be affected. The
current procedure only respects the current theme's settings if the color range setting is set to
Theme.

In the Set Color Ranges dialog box, you can also select Continuous or Discrete to determine
how the color scale is generated. When Continuous is selected, the color scale is a gradient,
and each color in the color scale represents a different value. When Discrete is selected, the
color scale is divided into segments. Each color in the color scale represents a range of
values.
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The following image shows a matrix marker chart that uses the Red/Yellow/Green color scale
with the Continuous option selected.

The Continuous option creates a more granular color scale, allowing you to see slight
differences between similarly colored chart components.
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The following image shows the same chart, with the Discrete option selected.

The Discrete option creates identifiable groups based on sections of the color scale.

When using the Theme color scale option, the default color scale type and number of
segments in discrete mode are dependent on the values of the colorScale property in the
theme that you are using. For example, if 5 colors are listed for the colorScale property in
StyleSheet being used as your theme, then 5 colors display in the color scale when the
discrete option is used.

Procedure: How to Add Color to Your Chart

To add color to your chart:

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Add one or more measures and dimensions to your chart.
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4. On the Format tab, expand the quick access menu and then click Axis from the drop-down
list, as shown in the following image.

5. In the Font section, click the color sample.

The color picker displays, as shown in the following image.
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The text color you select is displayed for the values on the specified axis (for example, x-
axis), as shown in the following image.

Procedure: How to Change the Color Scale in a Chart

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data..

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. Add one or more measures and dimensions to your chart.

4. Add a measure to the Color bucket.

Many different chart types generate a color scale from the Color bucket. Exceptions
include the ring pie and data grid chart types.

5. Right-click the measure field in the Color bucket and click Set color ranges.
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The Set Color Ranges dialog box displays, as shown in the following image.

6. From the list of colors, select a color range, as shown in the following image.

7. Optionally, select Continuous or Discrete to determine how the color scale is generated.

When Continuous is selected, the color scale is a gradient, and each color in the color
scale represents a different value.

When Discrete is selected, the color scale is divided into segments. Each color in the
color scale represents a range of values.

8. Click OK.
Note the change in the color and hues in your chart.
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Changing the Size of Charts and Risers

By default, when you create a chart, it fills the frame in which it is run, and risers and other
sections within the chart are sized accordingly. This makes the chart flexible, allowing it to run
in large and small containers alike without sacrificing the appearance and legibility of the
chart. This automatic sizing also means that you do not need to manually set any size
properties for the chart.

However, you also have the option to set a consistent size for the chart, if you prefer. You can
also determine the width of bars in a bar chart as a percentage of the riser area, and set the
width of risers in a bar, area, or line chart, based on the font size of the ordinal axis, or on an
exact value that you specify.

You can set a static height and width for a chart, so that it remains the same size no matter
where it is loaded. This can be useful, for example, if you want to add the chart to a
PowerPoint presentation or PDF, and want to leave room for other content on each slide or
page. To set the size of your chart, on the Format tab, select General from the quick access
menu. In the Other section, notice that the Fit to container option is set to Automatic, by
default, so that the chart automatically resizes to fill its container. To specify a size for the
chart, change this setting to Manual, and then provide a width and height for the chart, in
pixels. As you set these dimensions, you can select the Lock Aspect Ratio check box so that
as you change the width or height, the other dimension changes as well, to maintain the same
aspect ratio.

In bar, area, and line charts, values are represented by the height of a bar, area, or line at
different points along the ordinal axis, which displays different dimension value labels. These
points are generically called risers. You can set the width of these risers to fill the width of the
chart, resize them based on the font size of the ordinal axis labels, or resize them manually by
specifying a number of pixels.
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To access these options, on the Format tab, select Series, and leave All series selected. By
default, the riser width automatically adjusts based on the width of the chart to fill it evenly. In
the Shape section, change the Riser Width property to Tie to ordinal font size to have the riser
width increase with the size of the dimension labels on the ordinal axis of the chart. This is
most useful in charts that are oriented horizontally, so the risers and labels occupy roughly the
same amount of vertical space. To change the font size, on the Format tab, select Axis from
the quick access menu and then select X Axis from the axis drop-down menu. The Labels
section includes the options to change the font size of the axis labels. In the following image,
the font size was increased to 18, and, since the Riser Width property was set to Tie to ordinal
font size, the width of each riser has also increased accordingly.

You can also set the width of each riser in pixels. Set the Riser Width property to Manual and
then use the slider to set the riser width. If the riser width is too wide to fit all risers in the
chart frame, a scrollbar is added.

In bar charts, you can also set the percentage of the riser area that each bar or set of side-by-
side bars occupies, using the slider for the Riser Spacing property. Reducing this value
increases the amount of space between bars.

Creating Maps to Illustrate Trends

You can create maps to identify patterns or trends in your data. By converting data into values
that can be displayed on a map, you are able to visualize scenarios, illustrate hot spots, and
identify potential problem areas. For example, a law enforcement agency may use mapping
functionality to identify areas of higher crime within the locations they cover. You can also use
maps to determine how places are related, understand where things are located, and identify
the best actions to take. By illustrating trends on a map, a decision maker can identify
patterns easily, and reach conclusions sooner.

Creating Maps to Illustrate Trends

70 



You can access Map options from the Format tab, as a special tab is activated when a map is
initiated. This tab is shown in the following image:

You can format maps to display areas of emphasis through the use of demographic and
reference layers.

A Brief History of Mapping

An early example of how maps can be used to illustrate trends is the case of Dr. John Snow,
an epidemiologist who was one of the first to use data to map occurrences of cholera to find
the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to
visualize a trend that showed higher incidences of cholera closest to water pumps. This
example is shown in the following image.
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Maps also allow you to measure size, shape, and distribution to detect and quantify patterns,
and even perform predictive analytics. An example of how maps can help detect and quantify
patterns is the scenario in which a state agency used a mapping application to solve a
problem with their food stamp system. Using this application, odd food stamp redemptions,
such as rounded numbers transactions, were discovered. By plotting those transactions on a
map, the agency discovered that the redemptions appeared in the same geographic location.
Upon further investigation, the agency identified that individuals were selling their food stamps
at reduced prices, $50 worth of food stamps for $40 in cash, to others instead using them as
intended. This map example is shown in the following image.

When working with maps, the concepts of location intelligence and business intelligence are
important to understand. A Geographic Information System (GIS) captures, stores, analyzes,
manages, and presents data linked to a location, while Business Intelligence (BI) relies on the
conversion of raw data into meaningful information. Location intelligence is the process of
analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow
the recognition of patterns in your data, including the visualization and discovery of geospatial
outliers, which would not be easily discovered if you use the technology independently and
separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view
symbol layers for data-bound to a geo-location, such as state, country, and ZIP code, in an
integrated map viewer. Using metrics from your data, you can also visualize geographic roles or
dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or
assigned to a data field when you create a map.
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Db2 Web Query for i Designer and Esri Integration

Using Db2 Web Query Designer with the Esri integration, you can create maps that help you
illustrate or identify trends so you can take action quickly. Db2 Web Query architecture
provides the framework in which this system operates. Using a JavaScript map viewer, you can
navigate the interface easily, as shown in the following image.

In addition, this integration utilizes the capabilities of Esri by leveraging the ArcGIS JavaScript
API and content. Specifically, you can integrate data into maps with published content in
ArcGIS Online platform. For more information, see http://www.esri.com/software/arcgis/
arcgisonline. Additionally, by using this integration, you can include information about
demographics, spending habits, crime, and lifestyle to maps that contain your data. These
maps include layers with extensive demographic or reference detail and topography and allow
you to view information about people, businesses, climate, and much more.

You can create the following maps in Db2 Web Query Designer:

Choropleth. A common thematic map that uses geographical measures (for example,
states and countries), representing the values aerially while employing a varying intensity of
colors. It is useful for visualizing location-based data, trends, and distributions across a
geographic area. The color hues for Choropleth maps are dictated by the legend, based on
the selected measure, enabling you to determine data concentration across your map.
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Proportional Symbol (Bubble). A map that represents coordinates, such as an address or
intersection, using symbols of different sizes to represent any measure. These maps focus
on specific areas, for which data concentrations may vary. When the data concentration is
larger, the bubble will be bigger.

In addition, built-in zooming capabilities allow you to drill down to a specific geographic area of
focus easily. This allows you to get a closer look at regional or local data, draw inferences, and
make recommendations, without changing the initial view of your data.

Using the Esri integration in Db2 Web Query Designer, you can also add the following layers to
your map:

Backgrounds. Display a layer that positions data as it is located, in context to other
geographical features, such as streets, terrain, and imagery. Some standard Background
options may combine road, aerial, and topographic data using a variety of symbols. Hosted
on ArcGIS, you can change your background at any time, to review your data in a different
context.

When you apply a Background to your map, its appearance changes. You can then adjust
the view of your data, showing different terrain or geographical views. Backgrounds provide
at least 17 levels of zoom. For more information, see https://developers.arcgis.com/
javascript/jsapi/esri.basemaps-amd.html.

The basemap options include:

Light Gray Canvas Map

Dark Gray Canvas Map

World Imagery with Labels

National Geographic World Map

Oceans Map

Open Street Map

World Imagery

World Street Map

Terrain with Labels

World Topographical Map
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Reference Layers. Display a layer of boundaries and locations that range from a
continental scale to country, state, and even local neighborhood. For example, if you are
viewing World data on electricity usage, you may want to add a Reference Layer that
displays the borders and concentration of your data within each country.

Demographic Layers. Display a layer of information about people and businesses in a
specific demographic area. This includes the United States and 120 other countries.
Demographic Layers are thematic maps that provide additional information about the
location, such as spending habits, population, and lifestyles. You can add Demographic
Layers to a map about sales data, to identify new locations for stores, based on the
spending habits for a specific area.

Both mapextent and the Layers menu functionality are applied to your map when you select a
Background, Reference Layer, or Demographic Layer. Mapextent is an automatic view of the
map. Layers is a menu that appears on the map and provides access to options that allow you
to adjust the information that is being displayed.

The map example in the following image shows the use of layers.

Note: Backgrounds, Demographic Layers, and Reference Layers can be accessed from the
Format tab. These layers are static, standard options that Esri provides for use with Db2 Web
Query Designer, and do not change based on the data source that you select.
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Adapter for Esri ArcGIS Configuration for Demographic Layers

In order for demographic layers to draw, you must configure the Db2 Web Query Server to
enable them. Some features, such as demographic and reference layers that require
authentication and certain simplified geography functions, may additionally require a refresh
token. You can acquire the refresh token using your Esri ArcGIS credentials.

Procedure: How to Configure the Adapter for Esri ArcGIS to Enable Demographic Layers to Draw

1. From the plus menu of the Db2 Web Query Hub, or from the Db2 Web Query Home Page,
click Get Data.

2. On the Get Data page, double-click New Data Source.

3. From the list of adapters, double-click ESRI ArcGIS.

The Add Connection for Esri ArcGIS panel opens.

Note: To find the Esri ArcGIS adapter option more easily, select GIS from the Available
drop-down list, or use the search box.

4. Basic connection parameters for this adapter are supplied automatically. To access
secured Esri ArcGIS features that require named authentication, configure the Adapter for
Esri ArcGIS with a refresh token.

Click Get Refresh Token. The Esri ArcGIS Sign In page opens. Type your username and
password and then click Sign In.

You are returned to the Configure Connections window.
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5. In the Add Connection for Esri ArcGIS panel, click Configure, as shown in the following
image.

Once this is configured, ESRI ArcGIS is added to the Get Data page in the Upload Files
category.

Configuring an Esri On Premise Environment

The Esri On Premise functionality enables you to download and access mapping files through
the use of a local Application Programming Interface (API). Once you download and configure
the API, you do not need an internet connection to utilize the robust mapping features that Esri
provides. For information on downloading and configuring the API that controls this feature, see 
How to Download and Configure the ArcGIS JavaScript API on page 78.
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The Esri On Premise functionality provides you with local access to Esri mapping files. This is
particularly useful if you are away from your office or without an internet connection. You may
also be using a mobile device, such as an iPad or smartphone with a large screen, without an
internet connection. The following mapping components are supported when using the Esri On
Premise functionality:

Offline Basemaps. Basemaps are an offering from ArcGIS. Standard basemaps are
provided for your use offline. For example, there is an Oceans basemap and a Terrain with
Labels basemap. These basemaps are also known as backgrounds. In an online setting,
there are 10 basemaps available. In order to use offline basemaps you need to use a tiled
mapservice published in the ArcGIS Server.

Offline Geographic Roles. Geographic Roles are used to visualize measures with commonly
known dimensions (for example, Country, State, Cities, and so on). These provide the
location information often in the form of (x/y) needed to plot on a map. Geographic roles
are pre-defined for online users through ArcGIS Online. A geographic role defines the
geographic component that you can select when creating a map (for example, State or
Continent). For an offline user, the options that display can be customized in the
geoservices.xml file. For more information, see Adding a Custom Geographic Role on page
111.

Note: Demographic Layers are not supported in an Esri On Premise environment.

Procedure: How to Download and Configure the ArcGIS JavaScript API

You can use this procedure to download and configure the API that controls the Esri On
Premise environment.

1. Sign in to Esri ArcGIS.

2. In your browser, navigate to the following URL to download the API: https://
developers.arcgis.com/downloads/#javascript

3. Navigate to Version 3.28 of the ArcGIS API for JavaScript, as shown in the following image.

4. Click arcgis_js_v328_api.zip to download the API.

5. In /qibm/userdata/qwebqry/base80/config/web_resource, create a folder named
arcgis_api.
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6. Open the arcgis_js_v328_api.zip file downloaded in step 4 and navigate to
arcgis_js_v328_api\arcgis_js_api\library\3.28\3.28.

7. Extract the files in that folder to the /qibm/userdata/qwebqry/base80/config/
web_resource/arcgis_api folder.

8. Next, verify the path to the API in the Administration Console, as shown in the following
image.

Note: This is the path to which you extracted the API files. For example, /web_resource/
arcgis_api.

This field identifies the path to the internal ArcGIS Javascript API Source that develops
ESRI-based maps. This setting is blank, by default, indicating that the use of the internal
API source to develop ESRI maps is not activated. The API that is referenced is https://
js.arcgis.com/3.28/, by default. To direct Db2 Web Query Designer to use the internal
ArcGIS Javascript API to develop ESRI maps, enter the path to the local API files that you
extracted into this setting.

Note: This path should be a relative path that is accessible within the local install.

9. Click Save.

10. Next, open the following two local API files in a text editor:

/qibm/userdata/qwebqry/base80/config/web_resource/arcgis_api\init.js

/qibm/userdata/qwebqry/base80/config/web_resource/arcgis_api\dojo\dojo.js

In both files, search for HOSTNAME_AND_PATH_TO_JSAPI to locate the baseUrl property.
Replace the string [HOSTNAME_AND_PATH_TO_JSAPI] in baseUrl:"https://
[HOSTNAME_AND_PATH_TO_JSAPI]dojo" with the path to your on-premise ArcGIS server.
For example:

baseUrl:"https://localhost/arcgis/jsapi/jsapi/dojo"

11. In the Administration Console, click Clear Cache to clear the browser cache. Your
configuration is complete.
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Creating and Customizing Maps in Db2 Web Query Designer

The following procedures provide step-by-step instructions on how to create and customize
maps.

As you create your maps, you can use the following built-in map viewer features:

You can use the plus (+) and minus (-) symbols, , within the map to zoom in and out of
different areas of the map. You can also click your left mouse button to zoom in to a
specific location.

Like all HTML5 visualizations, the highlighted markers and regions on a map support drill,
multi-drill, auto-linking, and informational tooltip features.

You can use the Pan / Selection button to alternate between the Pan and Selection
controls. This option is in the upper-right corner of the map.

Creating a map chart using the US Zipcode 5 Georole with more than 2000 polygons will
fail to draw.

Procedure: How to Create an Esri Choropleth Map

Note: The default option of creating a map utilizes the ArcGIS JavaScript API that Esri provides.

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Content picker, select the Choropleth map chart type.
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A blank map displays and the Location bucket is enabled, as shown in the following
image.

4. Add a Geolocation field to the Location bucket.

This field, which already has a geographic role assigned, is denoted with a Geo icon, ,
in the Resources panel.

The canvas refreshes, and your map displays.

5. Before saving your map, to add insight, you can also do the following:

Click Run in new window, to see a run-time view of your map.

Add a measure or dimension to the Color bucket, to color your chart by that underlying
data value. When you add a dimension field to the Color bucket, a legend displays for
the values in that field. Note that each area in a choropleth map can only display one
color at a time, so it may be preferable to use a dimension for which each geographic
area will return a single value. If you specify a measure in the Color bucket, a color
scale is generated.

Add a field to the Tooltip bucket, which will display tooltip information when you place
your mouse over an area of the map.

Add a Background, Demographic Layer, or Reference Layer from the Format tab, under
Map options.
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6. Click Save to save your map.

Procedure: How to Create an Esri Proportional Symbol (Bubble) Map

1. Open Db2 Web Query Designer. On the Db2 Web Query Hub, click the plus menu and then
click Create Visualizations, or, on the Db2 Web Query Home Page, click Visualize Data.

Db2 Web Query Designer opens in a new browser tab.

2. Select a workspace and a data source available from that workspace.

Once you select a data source, Db2 Web Query Designer loads with options to create a
single content item.

3. On the Chart picker, select Proportional Symbol for the map type.

A blank map displays and the Location bucket is enabled.

4. Place a data field with a defined geographic role in the Location bucket.

This field, which already has a geographic role assigned, is denoted with a Geo icon, ,
in the Data panel.

A basic bubble map displays, as shown in the following image.

5. Before saving your map, to add insight, you can also do the following:

Click Run in new window, to see a run-time view of your map.
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Add a measure or dimension to the Color bucket to color your chart by that underlying
data value. Adding a dimension creates a legend with a different color assigned to
each value. Adding a measure generates a color scale.

Add a measure to the Size bucket, to control the size of the bubbles on your map.

Add a field to the Tooltip bucket, to display tooltip information when you place your
mouse over an area of the map at run time.

Add a Background, Demographic Layer, or Reference Layer from the Format tab, under
Map options.

6. Click Save to save your map.

Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map.
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2. On the Format tab, on the Map options tab, select Base map and choose from the
available options, as shown in the following image.

3. Select one of the following options:

World Street Map

Terrain with Labels

Oceans Basemap

OpenStreetMap

World Imagery
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Imagery with Labels

Light Gray Canvas

National Geographic World Map

Dark Gray Canvas

None

Note: The Imagery with Labels Background provides the terrain for your map, ranging from
land contours to city streets.

Once you make a selection, the background of the map refreshes. You can continue to
change your background until it displays the desired information.

Procedure: How to Add Demographic Layers to a Map

1. Create a new map or open an existing map.

2. On the Format tab, in the Map options group, click the Demographic layer drop-down and
click Demographic Layers.
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3. Select from various population and lifestyle groups, as shown in the following image.

Note: These are pre-defined demographic profiles, provided by Esri ArcGIS. Esri periodically
retires older demographic layers.

You can select multiple options in either category to gain additional insight into your data.
Specifically, each Demographic Layer has its own profile and provides a layering option,
when comparing values across different layers or profiles.

4. Click OK.
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The Demographic Layers that you select are applied to your map. The map engine displays
the different groups with unique hues and coloring. You can use the Table of Contents or
Layers option, to toggle between the different layers that you have specified. The Layers
option is shown in the following image.

Note: You can select and clear the check boxes to enable the display of one or more
Demographic Layers to compare and contrast the different demographic scenarios.

Procedure: How to Add Reference Layers to a Map

1. Create a new map or open an existing map.

2. On the Format tab, in the Map options group, click the drop-down for Reference layer.
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The list of Reference Layers displays, as shown in the following image.

3. Select one or more Reference Layers, such as World Countries, to add to your map, and
then click OK.
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Your map refreshes, and the definitions and borders of the References Layers display on
the canvas. You can use the Table of Contents or Layers option, to toggle different
Reference Layers in your map. These options are shown in the following image.

Reference: Query Buckets by Map Type

This section presents the Query buckets that display, by map type.

Query bucket Choropleth Map Proportional Symbol Map

Geo. One data field,
specifically a field
containing location data
(for example, State).

Color. One data field.

Tooltip. One or more
data fields (not
required).

Multi-page. Up to one
data field (not required).
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Query bucket Choropleth Map Proportional Symbol Map

Size. One data field.

Reference: Geographic Roles

Geographic roles have been unified to access 58 world administrative boundaries down to the
postal code level, out of the box. You can access administrative boundaries for approximately
250 countries with a second level license, which is a paid service from Esri. Enter your second
level license code by clicking the License button on the ribbon.

Note: Geographic roles are only available with Esri maps.

This section contains information on the geographic roles that are supported for Esri maps.

Geographic Role Description Maps Supported

CONTINENT World Continents Choropleth, Proportional
Symbol

COUNTRY World Countries Choropleth, Proportional
Symbol

STATE World Admin Divisions Choropleth, Proportional
Symbol

CITY World Cities Proportional Symbol

COUNTY World Counties Choropleth, Proportional
Symbol

POSTAL-CODE Postal Code Choropleth, Proportional
Symbol

Note: This is a new, simplified list of geographic roles (dimensions) that you can utilize when
creating a map chart. This unified list of roles provides worldwide mapping of administrative
boundaries down to the postal code level. In Db2 Web Query Designer, the new roles display,
by default, when assigning a geographic role.

The following table illustrates the geographic roles and their dependencies. Level 1 indicates
the highest level of hierarchy and level 5 is the lowest level of hierarchy.
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Region Hierarchy Level Geographic Role

World 1 CONTINENT

2 COUNTRY

3 STATE

4 CITY

5 POSTAL CODE

Procedure: How to Access Second Level Licensed Geographies for Esri Maps

1. Click Workspace on the Reporting Server Web Console sidebar.

2. Click License on the ribbon.

The License Management pane opens, as shown in the following image.

3. Enter your Esri second level license code in the license_2nd_level_maps field.

4. Click Save and Restart Server.

Once the second level license is enabled, you can use the standard administrative and postal
geographic roles to access these additional geographic boundaries.

Note: The server must be configured for Unicode if Unicode characters exist in the data.
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Reference: List of Geographic Locations

The Db2 Web Query Server Console provides a list of first and second level map administrative
regions. You can open the list by clicking the Settings menu on the Workspace page ribbon,
pointing to Geo Services and selecting General maps info. This opens the list of administrative
regions and postal levels, as shown in the following image.

The regions that say Paid in the Maps license column are the additional regions you can
access with a second level license.

The source for the country administrative level is provided by the Esri World map. Country is
administrative level 0.

The source for the State georole can be provided by the Esri World map or by shape files.
When there is a second level license, the state administrative level can be level 1 or level
2.

The source for the County georole can be provided by the Esri World map or by shape files.
When there is a second level license, the county administrative level can be level 3 or level
4.

The source for the City georole can be provided by the Esri World map or by shape files.
When there is a second level license, the city administrative level is level 5.
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The source for the Postal Code georole can be provided by the Esri World map or by shape
files. When there is a second level license, the postal code administrative level can be 3,
4, or 5.

Some georoles may not be applicable to specific countries. You can see the details of each
country and its administrative levels by right-clicking the country name and clicking Drill to
administrative levels or Drill to postal levels, as shown in the following image.

Clicking Drill to administrative levels opens the list of States for the country, as shown in the
following image.

Clicking any link opens information about the next level georole.
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Clicking Drill to postal levels opens the list of postal levels for the country, as shown in the
following image.

Right-clicking a link in any georole column other than the Country column opens a summary of
the values for that georole, as shown in the following image.

Administrative Boundaries for Level 1 Countries

Administrative boundaries for the United States are automatically included by Esri.

The following table lists the Level 1 countries and their Level 1 and Level 2 administrative
levels for available world countries and territories. For some countries, no additional
administrative levels are added with a second level license.
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Country Postal Code Level 1
Administrative Level

(Number of Values)

Level 2
Administrative Level

(Number of Values)

Albania 2 - digit Qarke (12) Bashkia (61)

Andorra 5 - digit Parroquies (7)

Argentina 5 - digit Departamentos
(525)

Australia 4 - digit Local Government
Areas (569)

Austria 4 - digit Gemeinden (2120)

Belarus 6 - digit Woblaszi (7) Raioni (129)

Belgium 4 - digit Communes (589)

Bosnia and
Herzegovina

5 - digit Kantone (18) Opstine (142)

Brazil 5 - digit Municipios (5565)

Canada 3 - digit Census Divisions
(293)

Census
Subdivisions (5243)

Chile 2 - digit Provincias (54)

China 2 - digit Counties City
Districts (2855)

Costa Rica 2 - digit Cantones (81) Distritos (473)

Croatia 2 - digit

5-digit for 2nd level
license

Zupanije (21) Opcine (556)

Cyprus 2 - digit

4-digit for 2nd level
license

Eparchia (6) Dimoi (615)
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Country Postal Code Level 1
Administrative Level

(Number of Values)

Level 2
Administrative Level

(Number of Values)

Czech Republic 2 - digit

6-digit for 2nd level
license

Orp (206) Obce (6253)

Denmark 4 - digit Kommuner (99)

Estonia 5 - digit Maakonnad (15) Vallad (213)

Finland 5 - digit Seutukunnat (70) Kunnat (317)

France 5 - digit Cantons (1972) Communes (36571)

Germany 5 - digit Municipilaties

Gibraltar 3/4/5 - digit

Greece 5 - digit Nomoi (75) Dimoi (326)

Holy See (Vatican
City State)

5 - digit

Hong Kong 6 - digit Shih Zizhiqu (18)

Hungary 2 - digit

4-digit for 2nd level
license

Kistersegek (175) Telepulesek (3177)

Iceland 2 - digit

3-digit for 2nd level
license

Landsvaedi (8) Sveitarfelog (74)

India 6 - digit Districts (640) Subdistricts (5783)

Italy 5 - digit Provincias (110) Comuni (8047)

Japan 3 - digit Prefectures (47) Municipalities
(1901)
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Country Postal Code Level 1
Administrative Level

(Number of Values)

Level 2
Administrative Level

(Number of Values)

Kenya 1 - digit Wilaya (47) Districts (158)

Korea, Republic of 3 - digit Si Gun (230)

Latvia 2 - digit

4-digit for 2nd level
license

Rajons (33) Novadi (119)

Liechtenstein 4 - digit Landschaften (2) Gemeinden (11)

Lithuania 2 - digit

5-digit for 2nd level
license

Apskritys (10) Savivaldybes (60)

Luxembourg 4 - digit Cantons (12) Communes (105)

Macedonia, the
former Yugoslav
Republic of

2 - digit

4-digit for 2nd level
license

Statisticki Regioni
(8)

Opstini (80)

Malta 3 - digit Districts (6) Local Councils (68)

Mexico 3 - digit Estados (32)

Monaco 5 - digit Quartiers (9)

Montenegro 2 - digit

5-digit for 2nd level
license

Opstina (21)

Netherlands 4 - digit Gemeenten (380)

New Zealand 4 - digit Territorial
Authorities (68)

Area Units (1911)

Norway 4 - digit Okonomisk regioner
(89)

Kommuner (428)
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Country Postal Code Level 1
Administrative Level

(Number of Values)

Level 2
Administrative Level

(Number of Values)

Poland 5 - digit Gminy (2479) Gminy Miasta
(3119)

Portugal 4 - digit Concelhos (308) Freguesias (3092)

San Marino 5 - digit Castelli (9)

Serbia 5 - digit

5-digit (1156) for
2nd level license

National (1)

Singapore 2 - digit Regions (5) Planning Areas (55)

Slovakia 2 - digit

6-digit for 2nd level
license

Okresy (79) Obce (2927)

Slovenia 2 - digit

4-digit for 2nd level
license

Statisticne Regije
(12)

Obcina (212)

South Africa 2-digit

4-digit for 2nd level
license

Municipalities (234)

Spain 5 - digit Provincias (52) Municipios (8122)

Sweden 5 - digit Kommuner (290)

Switzerland 4 - digit Gemeinden (2225)

Taiwan 3 - digit Township Districts
(368)

Turkey 5 - digit Iller (81) Ilceler (970)

United Kingdom 4 - digit Districts (391)
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Administrative Boundaries for Level 2 Countries

The following table lists countries that are accessible only with a second level license.

Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Afghanistan 4-digit Velayat (34) Woluswali (398)

Algeria 2-digit Wilayat (48)

American Samoa 5-digit Counties (77)

Angola Provincias (18) Municipios (161)

Anguilla 7-digit Districts (14)

Antigua and Barbuda Parishes (8)

Armenia 2-digit Marzer (11)

Aruba Districts (8)

Azerbaijan 2-digit Regions (10) Rayonlar (74)

Bahamas Islands (19) Districts (32)

Bahrain 2-digit Muhafazat (5)

Bangladesh 2-digit Zila (64) Upazila (553)

Barbados Parishes (11)

Belize Districts (6) Constituencies (31)

Benin Departements (12) Communes (77)

Bermuda 4-digit Parishes (11)

Bhutan 2-digit Dzongkhags (20)

Bolivia, Plurinational
State of

Departamentos (9) Provincias (112)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Botswana Districts (9) Sub-Districts (28)

British Virgin Islands National (1) Electoral Districts
(9)

Brunei Darussalam 2-digit Daerah (4) Mukim (38)

Burkina Faso Regions (13) Provinces (45)

Burundi Provinces (17) Communes (129)

Cambodia Khaet (25)

Cameroon Regions (10) Departements (58)

Cape Verde 2-digit Concelhos (22) Freguesias (32)

Cayman Islands 8-digit Districts (6)

Central African
Republic

Prefectures (17) Sous-Prefectures
(51)

Chad National (1)

Colombia 2-digit Departamentos (33) Municipios (1122)

Comoros Islands (3)

Congo Departements (12)

Congo, the
Democratic Republic
of the

Districts (48) Territoires (188)

Côte d'Ivoire Regions (32) Departements (95)

Cuba Provincias (16) Municipios (168)

Djibouti Regions (6)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Dominica Parishes (10)

Dominican Republic 5-digit Provincias (32) Municipios (155)

Ecuador 6 - digit Cantones (224) Parroquias (1040)

Egypt 2-digit States (27)

El Salvador 7-digit Departamentos (14) Municipios (262)

Equatorial Guinea Regions (2) Provinces (7)

Eritrea Zobas (6) Subzobas (52)

Ethiopia Kililoch (11) Awrajja (85)

Faroe Islands 3 - digit Syslur (6) Kommunur (30)

Fiji Provinces (15)

French Guiana 5-digit Cantons (14) Communes (22)

French Polynesia 5-digit Iles (5) Communes (48)

French Southern
Territories

Districts (4)

Gabon Provinces (9)

Gambia Local Government
Areas (8)

Georgia Regions (12) Rajone (77)

Ghana Regions (10) Districts (216)

Greenland 4-digit Kommuner (6)

Grenada Parishes (7)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Guadeloupe 5-digit Cantons (28) Communes (32)

Guam 5-digit County Subdivisions
(19)

Guatemala 5-digit Departamentos (22) Municipios (334)

Guernsey 5-digit Parishes (15)

Guinea Regions (8) Prefectures (34)

Guinea-Bissau 4-digit Regioes (9) Sectores (38)

Guyana Regions (10)

Haiti Arrondissements
(42)

Communes (140)

Honduras 2-digit Departamentos (18) Municipios (298)

Indonesia 3-digit States (34)

Iran, Islamic
Republic of

1-digit Provinces (31) Subprovinces (397)

Iraq Muhafazat (18) Kaza (109)

Ireland Counties (34) Electoral Divisions
(3441)

Isle of Man 5-digit Sheadings (6) Districts (24)

Israel 2-digit States (6)

Jamaica Parishes (14) Constituencies (62)

Jersey 5-digit Parishes (12)

Jordan 5-digit Muhafazat (12) Nahia (51)

Creating Maps to Illustrate Trends

102 



Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Kazakhstan 4-digit Oblystar (16) Audandar (209)

Korea, Democratic
People's Republic of

Do (14)

Kosovo 2-digit Obstina (38)

Kuwait 2-digit Muhafazat (6) Localities (137)

Kyrgyzstan 4-digit Oblasttar (9) Rajondor (46)

Lao People's
Democratic Republic

Khoueng (17) Muang (142)

Lebanon Muhafazat (6) Caza (26)

Lesotho Districts (10)

Liberia Counties (15)

Libyan Arab
Jamahiriya

Schabiyat (22)

Macao 6-digit Parishes (8)

Madagascar 3-digit Regions (22) Districts (114)

Malawi Regions (3) Districts (30)

Malaysia 2-digit Negeri (16) Daerah (144)

Maldives 2-digit Atolls (20)

Mali Regions (9) Cercles (50)

Marshall Islands 3-digit Municipalities (34)

Martinique 5-digit Arrondissements (4) Communes (34)

Mauritania Wilayas (13) Moughataas (53)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Mauritius Districts (10)

Mayotte Communes (17)

Micronesia,
Federated States of

5-digit States (4)

Moldova, Republic
of

4-digit Raioane (37)

Mongolia 4-digit Aimags (22) Sums (338)

Montserrat Parishes (3)

Morocco 2-digit Regions (16) Provinces (75)

Mozambique 2-digit Provincias (11) Distritos (142)

Myanmar States and Divisions
(15)

Namibia Regions (13) Constituencies
(119)

Nauru Districts (14)

Nepal Zones (14) Districts (75)

New Caledonia 5-digit Provinces (3) Communes (34)

Nicaragua Departamentos (17) Municipios (153)

Niger Regions (8)

Nigeria States (37) Local Government
Areas (774)

Northern Mariana
Islands

5-digit Municipalities (4)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Oman 1-digit Muhafazat (11) Wilayat (61)

Pakistan 2-digit Provinces (8) Districts (146)

Palau 5-digit States (16)

Palestinian Territory,
Occupied

Territories (2) Muhafazat (16)

Panama Provincias (12) Distritos (76)

Papua New Guinea Provinces (22) Districts (87)

Paraguay Departamentos (18) Distritos (251)

Peru 2 - digit Provincias (195) Distritos (1834)

Philippines 4-digit Provinces (87) Municipalities and
Cities (1634)

Pitcairn 8-digit Islands (4)

Puerto Rico 5-digit Municipios (78) County Subdivisions
(902)

Qatar Municipalities (7) Zones (90)

Republic of South
Sudan

States (10)

Réunion 5-digit Arrondissements (4) Communes (24)

Romania 6 - digit Judete (42) Comune (3181)

Russian Federation 4-digit Federal Subjects
(80)

Raioni (2345)

Rwanda Provinces (5) Districts (30)

1. Creating Charts

Creating Charts  105



Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Saint Kitts and
Nevis

States (2) Parishes (14)

Saint Lucia Quarters (10)

Saint Vincent and
the Grenadines

4-digit Parishes (6)

Samoa 3-digit Regions (4) Districts (43)

Sao Tome and
Principe

Province (2) Distritos (7)

Saudi Arabia 2-digit States (13)

Senegal Regions (14)

Seychelles Districts (25)

Sierra Leone Provinces (4) Districts (14)

Solomon Islands Provinces (10)

South Sudan 2-digit States (10)

Sri Lanka 2-digit Districts (25) DS-Divisions (331)

Sudan 2-digit States (15)

Suriname Districten (10) Ressorten (62)

Svalbard and Jan
Mayen (IE)

Counties (34) Electoral Divisions
(3441)

Svalbard and Jan
Mayen (SJ)

4-digit National (1) Kommuner (4)

Swaziland 1-digit Districts (4)

Syrian Arab Republic Muhafazat (14) Manatiq (61)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Tajikistan Regions (5) Raioni (64)

Tanzania, United
Republic of

Mkoa (30) Wilayah (169)

Thailand 2-digit Changwate (77) Amphoe (928)

Timor-Leste Districts (13) Subdistricts (65)

Togo Regions (5)

Tokelau Atolls (3)

Tonga Island Divisions (5)

Trinidad and Tobago Municipalities (15)

Tunisia 4-digit Wilayat (24)

Turkmenistan 3-digit Welayaty (6) Etraplar (65)

Turks and Caicos
Islands

8-digit Districts (6) Localities (38)

Tuvalu Islands (9)

Uganda Consolidated
Districts (75)

Counties (110)

Ukraine 3-digit Obstina (38)

United Arab
Emirates

States (7)

United States Minor
Outlying Islands

Islands (5)

United States Virgin
Islands

5-digit National (1) Islands (3)
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Country Postal Code Highest
Administrative Level

(Number of Values)

Lowest
Administrative Level

(Number of Values)

Uruguay 5 - digit Secciones (232) Segmentos (4301)

Uzbekistan 4-digit Viloyati (14) Tuman (171)

Vanuatu Provinces (6)

Venezuela,
Bolivarian Republic
of

2 - digit Estados (25) Municipios (367)

Viet Nam 2 - digit Provinces (63) Districts (698)

Wallis and Futuna 5 - digit Kingdoms (3)

Yemen Muhafazat (21) Muderiah (333)

Zambia 5 - digit Provinces (10) Districts (103)

Zimbabwe Provinces (10) Districts (91)

Example: Using a Second Level License to Map French Postal Codes

The request used in this example references data about French state names, city names, and
postal codes. This data is readily available online. The data in this example was downloaded
from https://www.aggdata.com/free/france-postal-codes which is available for free using a
Creative Commons Attribution 4.0 license detailed at https://creativecommons.org/
licenses/by/4.0/. Once you download the data, you can upload it to the server to create the
data file and synonym for use in requests. This example assumes that the data and synonym
are in the ibisamp application on the server.

Note: We take no responsibility for the accuracy or continued existence of this data on this
site. It is being used only as an example of the detailed administrative boundaries available
with a second level license.
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The Master File for the uploaded data follows. The Master File generated by the upload
procedure was edited to change the first field name to COUNTRY and to remove the folder
declarations.

FILENAME=FR_POSTAL_CODES, SUFFIX=DFIX    ,
 DATASET=ibisamp/fr_postal_codes.ftm (LRECL 1140 RECFM V, BV_NAMESPACE=OFF, 
$
  SEGMENT=FR_POSTAL_CODES, SEGTYPE=S0, $
    FIELDNAME=COUNTRY, ALIAS=E01, USAGE=A50V, ACTUAL=A50V,
      TITLE='Country for State',
      GEOGRAPHIC_ROLE=COUNTRY,  $
    FIELDNAME=STATE, ALIAS=E02, USAGE=A21V, ACTUAL=A21V,
      MISSING=ON,
      TITLE='State',
      GEOGRAPHIC_ROLE=STATE,  $
    FIELDNAME=COUNTY, ALIAS=E03, USAGE=A25V, ACTUAL=A25V,
      MISSING=ON,
      TITLE='County',
      GEOGRAPHIC_ROLE=COUNTY,  $
    FIELDNAME=CITY, ALIAS=E04, USAGE=A48V, ACTUAL=A48V,
      MISSING=ON,
      TITLE='City',
      GEOGRAPHIC_ROLE=CITY,  $
    FIELDNAME=POSTAL_CODE, ALIAS=E05, USAGE=A16V, ACTUAL=A16V,
      MISSING=ON,
      TITLE='Postal Code',
      GEOGRAPHIC_ROLE=POSTAL-CODE,  $
    FIELDNAME=PLACE_NAME, ALIAS=E06, USAGE=A56V, ACTUAL=A56V,
      MISSING=ON,
      TITLE='Place Name', $
    FIELDNAME=GEO_POINT, ALIAS=E07, USAGE=A150, ACTUAL=A150,
      TITLE='GIS Point',
      GEOGRAPHIC_ROLE=GEOMETRY_POINT,  $

The Access File for the uploaded data follows.

SEGNAME=FR_POSTAL_CODES, 
  DELIMITER=',', 
  CDN=COMMAS_DOT, 
  CONNECTION=<local>, $

The following Db2 Web Query procedure generates a choropleth map that shows the postal
codes from the uploaded data source. The DEFINE field is used to assign different numeric
values to each field. When used in the Color bucket, this DEFINE field makes it easier to
differentiate the different postal code areas.
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DEFINE FILE fr_postal_codes
 FOURTH_CHAR/I1 ( TITLE = 'Fourth,Character' ) =
        SUBSTRING(FR_POSTAL_CODES.FR_POSTAL_CODES.POSTAL_CODE, 4, 1);
END

SET COMPONENT=TableChart_1
SET ARVERSION=2
-DEFAULTH &WF_TITLE='Db2 Web Query Report';

GRAPH FILE fr_postal_codes
SUM FOURTH_CHAR
BY FR_POSTAL_CODES.FR_POSTAL_CODES.POSTAL_CODE
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET VZERO OFF
ON GRAPH SET GRWIDTH 1
ON GRAPH SET HAXIS 1008.0
ON GRAPH SET VAXIS 768.0
ON GRAPH SET LOOKGRAPH CHOROPLETH
ON GRAPH SET EMBEDHEADING ON
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
INCLUDE=IBFS:/WFC/Global/Themes/Standard/Default/theme.sty,$
TYPE=REPORT, TITLETEXT='Chart1', ORIENTATION=LANDSCAPE, 
ARREPORTSIZE=DIMENSION, 
    ARFILTER_TARGET='*', CHART-LOOK=com.esri.map, ARGRAPHENGINE=JSCHART, $
TYPE=DATA, COLUMN=N2, BUCKET=color, $
*GRAPH_SCRIPT

*GRAPH_JS_FINAL
"extensions": {
    "com.esri.map": {
        "overlayLayers":             [
                {
                    "ibiDataLayer": {
                        "map-metadata": {
"map_by_field": "FR_POSTAL_CODES.FR_POSTAL_CODES.POSTAL_CODE"
                        }
                    }
                }
            ],
        "baseMapInfo": {
            "customBaseMaps":                 [
                    {
                        "ibiBaseLayer": "dark-gray"
                    }
                ]
        }
    }
}

*END
ENDSTYLE
END
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When you run this procedure, the map displays postal codes in France, as shown in the
following image.

Adding a Custom Geographic Role

The GEO configuration editor in the Db2 Web Query Reporting Server provides a tool for editing
or adding properties for geographic roles.

On the Db2 Web Query Hub, from the Management Center, click Server Workspaces to access
the Db2 Web Query Reporting Server Workspace area. Alternatively, from the Db2 Web Query
Home Page, click the Settings menu and click Db2 Web Query Server. When the Db2 Web
Query Reporting Server browser interface opens, open the Tools menu and click Workspace.
The Workspace area opens.
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In the Reporting Server Workspace area click Settings, point to Geo Services, then click Edit
Configuration. The GEO configuration editor opens displaying the configured geographic roles,
as shown in the following image.

Reference: Editing the List of Geographic Roles

The following standard unified geographic roles are configured by default and cannot be
changed. These geographic roles create a hierarchy that can be used to drill down or up
between levels of administration in maps, reports, or charts.

CONTINENT.

COUNTRY.

STATE.

COUNTY.

CITY.

POSTAL CODE.

To add a geographic role to the configuration, you can add a new Esri map or a shapefile
hosted by the Server and associate a geographic role with the new map. You can also
implement NUTS geographic roles support.

Note: Some users may not be able to run maps with custom geographic roles when the default
reporting server security configuration is in place. To allow a user to run content with custom
geographic roles, on the Access Control page of the Reporting Server browser interface, right-
click the role that the user privileges are based on and click Directory/File Privileges, then
enable both the Execute and List privileges for geo_services_user.xml.
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Configuring Properties of Geographic Roles

The following describes columns for geographic roles in the configuration editor.

name 

Is the unique name of the geographic role. It cannot have spaces, but it can have
underscores (_).

Next to the name is an indicator of whether the role is a standard role or a customized
role.

title 

Is the description of the geographic role that is displayed in reports and in drop-down lists
in the Db2 Web Query tools.

returned_geometry 

Is the type of geographic data returned from the map service for rendering on the map.

Valid values include:

GEOMETRY_AREA

GEOMETRY_POINT

GEOMETRY_LINE

When you have configured the properties, click OK to return to the Geo Configuration Editor.

The new role will display on the list of roles, click Save to save it in the geographic
configuration.

Adding a New Role for an Esri Map

To add an Esri geographic role, click Add ESRI map on the Geographic Configuration Editor.
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The Create a new ESRI map role dialog box opens, as shown in the following image.

Configure the following map service properties.

name 

Is a name for the geographic role.

title 

Is a title to display in the Db2 Web Query tools.

returned_geography 

Select the type of geometry that is returned from the map service for this role. Valid values
are:

GEOMETRY_AREA. Returns JSON polygon definitions.

GEOMETRY_LINE. Returns JSON line definitions.

GEOMETRY_POINT. Returns a JSON point.

url 

Is the URL to the map service that provides the geographic data.
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Click Verify after entering the URL to verify that the map service is available by going to the
specified URL.

Service Parameters 

Add as parameters any additional geographic roles needed to identify the exact location of
the new role. For example, a city name needs state and country parameters.

Example: Adding the Db2 Web Query Regions Geographic Role

The following properties add the Db2 Web Query Regions role to the configuration.

Note: The parameter name corresponds to the field name in the FeatureLayer referenced in the
following URL:

http://services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS/rest/services/
wfretail_sub_regions/FeatureServer/0

Click OK when you have finished configuring the properties.

The new role is added to the configuration as a customized role, as shown in the following
image.

Click Save to save this role to the configuration.
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The following request uses the Db2 Web Query Regions geographic role in a map request.

DEFINE FILE WF_RETAIL_LITE

REGION/A50 (GEOGRAPHIC_ROLE=REGION) = BUSINESS_SUB_REGION;
END
 
GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
BY REGION
WHERE COUNTRY_NAME EQ 'United States'
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH CHOROPLETH
ON GRAPH SET STYLE *
TYPE=REPORT, CHART-LOOK=com.esri.map, $
TYPE=DATA, COLUMN=N2, BUCKET=color, $
*GRAPH_JS_FINAL
"extensions": {
"com.esri.map": {
"overlayLayers":
[
{
"ibiDataLayer": {
"map-metadata": {
"map_by_field": "
REGION"
}
}
}
],
"baseMapInfo":
{
"customBaseMaps":
[
{
"ibiBaseLayer": "gray"
}
]
}
}
}
*END
ENDSTYLE
END
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The output is shown in the following image.

Adding a New Role for a Server-Hosted Map

A server-hosted map is based on a shapefile. You must upload the shapefile (.dbf) to an
application folder accessible to the server. The server will transform it to ibijson format.

An ESRI shape file is actually a collection of at least four files:

.dbf file. The .dbf file is a standard database file used to store attribute data and object
IDs. A .dbf file is mandatory for shape files.

.shp file. The .shp file is a mandatory Esri file that gives features their geometry. Every
shapefile has its own .shp file that represents spatial vector data.

.shx file. The .shx file is a mandatory Esri shape index position file. This type of file is used
to search forward and backwards.

.prj file. The .prj file is an optional file that contains the metadata associated with the
shapefiles coordinate and projection system.

All files must have exactly the same name and to be located in the same directory. If they are
not, the shapefile conversion will fail.

When there are several possible keys associated with a geometry, a drop down list of detected
key names will be displayed. Select any one of these fields. No selection required when there
is a single geometry key.

The shapefile should only be in the GCS_WGS_1984 - World Geodetic System 1984 (decimal
degrees) coordinate system.
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To add a geographic role for a Server-hosted map, click Add WFRS map on the Geographic
Configuration Editor.

The Add WFRS hosted map dialog box opens, as shown in the following image.

Configure the following properties.

role name 

Is a name for the geographic role.

Geometry type 

Select either POLYGON or POINT from the drop-down list.

Esri shape 

Enter the name of the application directory where the shapefile resides, or click the ellipsis
(...) to navigate to the application directory. Then select the .dbf file for the role.

Load to app 

Enter the name of the application directory where you want to place the ibijson file, or click
the ellipsis (...) to navigate to the application directory.

Quantization type 

Quantization is the process of transforming a large set of input values to a smaller set of
values. When transforming the shapefile, the server will quantize points that are too close
together in order to optimize map rendering performance. Two methods are available for
quantization, LINEAR or GRID. The default is LINEAR.

Quantization_X 

Is the threshold value for the x-axis.
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Quantization_Y 

Is the threshold value for the y-axis.

If the map has multiple keys, a drop-down list displays so that you can select one.

Click OK when you have finished configuring the properties.

The new role is added to the configuration as a customized role, as shown in the following
image.

Click Save to save this role to the configuration.

You can test the role by right-clicking the role in the configuration editor and clicking Test. A
sample map will be generated, as shown in the following image.
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Adding NUTS Support

Nomenclature of territorial units for statistics (NUTS) are geographic roles specific to the
European Union.

To add NUTS geographic roles to the configuration, click Add NUTS support on the Geographic
Configuration Editor.

The NUTS geographic roles are added, as shown in the following image.

Click Save to save these roles to the configuration.

Adding Support for Extended Postal Codes

Click Add extended postal codes to add support for Level 1 and Level 2 postal codes used in
certain countries.

Customizing Vocabulary Rules

For each geographic role, a set of vocabulary rules define how to recognize when a field name
should automatically be assigned to that role. If you right-click a role, you can click Customize
vocabulary from the shortcut menu.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be
satisfied). Each vocabulary element contains words enclosed with special characters. Words in
the rule element are connected by the Boolean logic operation AND (all need to be satisfied).
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A word may be prefixed and/or suffixed with the percent character (%), which is a placeholder
for any sequence of characters. If an element contains more than one word, each word has to
be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in
the column name. Minus indicates that word must not be found in the column name.

For example, the following are the vocabulary rules for the role COUNTRY.

To add another rule, click Add optional.

When you are finished, click OK.

Click Save to save these rules to the configuration.

Reference: Customizing the List of Basemaps

You can edit an existing basemap definition or add a custom basemap.

Using Standard Basemaps

To add a new basemap or customize an existing basemap, select Basemap from the Object
drop-down list.
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Configuring Basemap Properties

The following is a description of the properties used for basemap configuration.

name 

Is the name of the basemap.

Next to the name is an indicator of whether the basemap is a standard basemap or a
customized basemap.

icon 

Is the name of the thumbnail for the basemap (for a standard basemap) or the URL to the
thumbnail (for a customized basemap) that will appear on the Basemap drop-down list in
the Db2 Web Query tools (for example, the Base map menu in Db2 Web Query Designer) or
the Change Basemap map widget.

title 

Is a title to display on the Basemap drop-down list in the Db2 Web Query tools or the
Change Basemap map widget.

url 

Is the URL to the map service that provides the basemap, for a customized basemap. The
map service URL can be copied from the URL field on the page showing a custom
basemap. For a standard basemap, the URL is already stored in the server geographic
configuration file and is not displayed.

type 

Valid values are tiled and vector.

addon_json 

Specifies additional JSON properties for rendering the map.

Editing the Properties of a Basemap

To customize the properties of an existing basemap, right-click the basemap line and click
Customize BASEMAP.
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The Customize Basemap dialog box opens, as shown in the following image.

Edit the properties you want to change. If you change the URL, you can click Verify to make
sure the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor Basemaps
page.

Adding a Custom Basemap

To add a new basemap to the configuration, click Add.
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The Create a BASEMAP dialog box opens, as shown in the following image.

Enter a name for the basemap, a URL to the thumbnail, a title to display, and the URL to the
map service that provides the basemap, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO configuration
editor Basemap page.

Reference: Customizing the List of Context Layers

To add a new context layer or customize an existing context layer, select ContextLayer from the
Object drop-down list.
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The following image shows the GEO configuration editor with the ContextLayer object selected.

Configuring Context Layer Properties

Following is a description of the properties used for context layer configuration.

name 

Is the name of the context layer.

Next to the name is an indicator of whether the context layer is a standard context layer or
a customized context layer.

authorization 

Is the type of authentication needed to access this context layer. Valid values are:

silent. Credentials for your ArcGIS application are provided in the connection string of
the Adapter for Esri ArcGIS.

none. No authorization is needed.

named. User credentials are provided in the connection string of the Adapter for Esri.

on premises. User credentials for a locally hosted ArcGIS server are provided in the
connection string of the Adapter for Esri.

layer type 

Is the type of context layer. For a cached layer, the layer type is tile. For a layer that is
rendered dynamically, the layer type is featurelayer.
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title 

Is a title to display on the demographic layer drop-down list in the Db2 Web Query tools.

addon_json 

Specifies additional JSON properties needed for rendering the context layer. For example,
smartMapping properties define the border styles within the context layer.

Depending on the type of context layer, the addon_json properties may resemble the
following:

"layerObjectType" : "esri/layers/ArcGISDynamicMapServiceLayer", 
    "smartMapping": { "webMapInfo": { 
        "queryString" : "id:id", 
        "itemDataUrl" : "url", 
        "layerTypeEx" : "layerType" 
}}

where:

esri/layers/ArcGISDynamicMapServiceLayer 

Defines the context layer as a dynamic map service.

id 

Is the ID of the context layer on Esri ArcGIS. This can be found in the URL for the layer
on the Esri ArcGIS site, or as the value of the "serviceItemId" property in the JSON
properties accessible from the service URL of the layer.

If there is no layer ID, then this property can be omitted.

url 

Is the map service URL for the layer. This should match the value that you provide for
the uri field.

layerType 

Is an optional value to specify the type of context layer. It can be one of the following
values:

group. Identifies the context layer as a group layer composed of multiple feature
layers. For more information, see https://developers.arcgis.com/javascript/latest/
api-reference/esri-layers-GroupLayer.html.

map-image. Identifies the context layer as a map image layer, which can contain
multiple sub-layers rendered as images rather than features. For more information,
see https://developers.arcgis.com/javascript/latest/api-reference/esri-layers-
MapImageLayer.html.
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feature. Identifies the context layer as a feature layer, which is a single layer
created from a map service or feature service. For more information, see https://
developers.arcgis.com/javascript/latest/api-reference/esri-layers-FeatureLayer.html.

imagery-tile. Identifies the context layer as an imagery tile layer, created from a
tiled image service. For more information see https://developers.arcgis.com/
javascript/latest/api-reference/esri-layers-ImageryTileLayer.html.

imagery. Identifies the context layer as an imagery layer, created from an image
service. For more information, see https://developers.arcgis.com/javascript/latest/
api-reference/esri-layers-ImageryLayer.html.

elevation. Identifies the context layer as an elevation layer used in a 3D
SceneView. For more information, see https://developers.arcgis.com/javascript/
latest/api-reference/esri-layers-ElevationLayer.html.

tile. Identifies the context layer as a tile layer, created from a cached map service.
For more information, see https://developers.arcgis.com/javascript/latest/api-
reference/esri-layers-TileLayer.html.

web-map. Identifies a complete, two-dimensional WebMap. For more information,
see https://developers.arcgis.com/javascript/latest/api-reference/esri-
WebMap.html.

web-scene. Identifies a complete, 3D web scene. For more information, see 
https://developers.arcgis.com/javascript/latest/api-reference/esri-WebScene.html.

If your context layer is neither a group layer nor a map image layer, the layerTypeEx
property is not needed.

For example, the add-on JSON for a map image layer may resemble the following:

"layerObjectType" : "esri/layers/ArcGISTiledMapServiceLayer", 
"smartMapping": { "webMapInfo": { 
    "queryString" : "id:1234567890abcdefghij1234567890ab", 
    "itemDataUrl" : 
"https://services5.arcgis.com/1234567890abcdef/arcgis/rest/services/
Layer_Name/FeatureServer", 
    "layerTypeEx" : "map-image" 
    }
}

uri 

Is the URL to the map service that provides the context layer.
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Customizing the Properties of an Existing Context Layer

To customize the properties of an existing context layer, click the down arrow next to a context
layer name or right-click the context layer line and click Customize context layer.

The Customize CONTEXTLAYER dialog box opens, as shown in the following image.

Edit the properties you want to change. If you change the URI, you can click Verify to make sure
the map service is valid and accessible.

When you are finished, click OK, then click Save on the GEO configuration editor Context
Layers page.

Adding a New Context Layer

To add a new context layer to the configuration, click Add.
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The Create a Customized CONTEXTLAYER dialog box opens, as shown in the following image.

Enter a name for the context layer, the authorization type, a layer type, a title to display, any
additional JSON needed for rendering the context layer, and the URI to the map service that
provides the context layer, and click Verify.

When you have configured the properties, click OK, then click Save on the GEO configuration
editor Context Layer page.

1. Creating Charts

Creating Charts  129



Using Your Extension in a Request

If you have installed and configured your extension as described, your extension will be
available for use in the Db2 Web Query tools as a chart type in the Other format category under
HTML5 Extension, as shown in the following image.
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When creating a chart using Db2 Web Query, chart extensions are available in the Custom
category when you expand the chart picker, as shown in the following image.

The attribute categories you defined in the dataBuckets object of your extension are available
in the Query pane in InfoAssist or Display panel in Db2 Web Query.
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Additionally, in Db2 Web Query, the properties defined in the propertyAnnotations object are
available on the Format tab, in the Other section, when General is selected in the Quick
Access menu. Clicking Extension properties opens the Extension properties panel, where you
can make changes to the available properties, as shown in the following image, which shows
properties for the liquid gauge chart extension.

The following syntax is added in the FOCEXEC:

The LOOKGRAPH value is EXTENSION.

The actual extension to use is identified in the chartType property of the *GRAPH_JS block
in the StyleSheet.

Using Your Extension in a Request

132 



For example, for a liquid gauge chart:

*GRAPH_JS
    chartType: "com.ibi.liquid_gauge",

Each custom attribute category name is prepended with a greater-than character (>). For
example, for a simple bar chart that has one label field and four value fields:

TYPE=DATA, COLUMN=N1, BUCKET= >labels, $
TYPE=DATA, COLUMN=N2, BUCKET= >value, $
TYPE=DATA, COLUMN=N3, BUCKET= >value, $
TYPE=DATA, COLUMN=N4, BUCKET= >value, $
TYPE=DATA, COLUMN=N5, BUCKET= >value, $

Extension chart properties are listed under the extensions:extension_name object. For
example, for a liquid gauge chart with the number of waves set to 3 and the wave color set
to a shade of dark blue, the properties appear as follows:

"extensions": {
    "com.ibi.liquid_gauge": {
        "waveCount": 3,
        "waveColor": "#083f9e"
    }
}

The following is a sample request using the liquid gauge extension.

GRAPH FILE wf_retail_lite
SUM PCT.WF_RETAIL_LITE.WF_RETAIL_SALES.QUANTITY_SOLD
BY WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.BUSINESS_REGION
WHERE_GROUPED WF_RETAIL_LITE.WF_RETAIL_GEOGRAPHY_CUSTOMER.BUSINESS_REG
ION EQ 'North America'
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH EXTENSION
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
TYPE=DATA, COLUMN=N2, BUCKET= >value, $
*GRAPH_JS_FINAL
"chartType": "com.ibi.liquid_gauge",
"extensions": {
    "com.ibi.liquid_gauge": {
       "waveCount": 3,
       "waveColor": "#083f9e"
    }
}
*END
ENDSTYLE
END
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Run the chart. The output is shown in the following image.

Configuring Automatic Refresh

Db2 Web Query Designer allows you to integrate real-time streaming data with your charts
using the Automatic refresh option. For example, for IoT analytics applications, if you
configured a connection to a streaming data source using the Kafka adapter, the Automatic
refresh option can be enabled to update your chart dynamically at a specified interval (in
seconds). Depending on your specific use case or requirements, you can configure multiple
charts using the Automatic refresh option and add them to assembled pages. Each chart will
refresh independently with updated data based on the specified refresh rate.

Considerations

The Automatic refresh option is supported for all chart types, except for maps (for example,
Proportional Symbol and Choropleth maps). The Automatic refresh option is not available for
reports in Db2 Web Query Designer. In addition, this option is not included in InfoAssist.
Automatic refresh is only supported for stand-alone charts. If you convert the chart to a page, a
warning appears, alerting you that automatic refresh will not be carried over.

Procedure: How to Enable and Configure the Automatic Refresh Option for a Chart

1. Create a new chart in Db2 Web Query Designer. To best utilize the automatic refresh
feature, use a streaming data source, such as one using the Kafka adapter.
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2. Choose a chart type from the chart picker, as shown in the following image.

3. Add measures and dimensions according to your requirements by dragging them onto the
canvas.

Note: You can also double-click a measure or dimension to add it to the relevant bucket or
drag it into the relevant bucket.

4. Apply any required formatting or styling to your chart (for example, adding a header or
footer).
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5. To turn on automatic refresh, on the Settings tab, expand the Content section. Select the
Enable auto-refresh check box, as shown in the following image.

6. By default, the refresh interval is set to 120 seconds. Use the spinner or type a value to
specify the refresh rate in seconds, which is the period of time to wait until the chart polls
the corresponding data source to reflect any updated data.

Note: You can specify a maximum value of 120 seconds (two minutes) as the refresh rate.

7. Click OK.

You can continue to build and modify your chart as required.

8. When you are finished, click Save on the Visualization toolbar to save your chart.

9. To test and verify that your chart is being refreshed correctly, locate it on the Hub, right-
click it and select Run from the context menu.

Observe your chart while it is running and make a note of any adjustments that should be
made. For example, if the chart is being refreshed too quickly, then you should consider
increasing the number of seconds specified for the Automatic refresh option.

Procedure: How to Disable the Automatic Refresh Option for a Chart

To disable the Automatic refresh option:

1. Open a visualization that uses automatic refresh. On the Db2 Web Query Hub, right-click a
visualization and click Edit.

The selected visualization opens in Db2 Web Query Designer.

2. On the Settings tab, expand the Content section.

3. Clear the Enable auto-refresh check box.

4. Save your content. When it is run, your content no longer refreshes automatically.
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SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
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OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
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This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of TIBCO Software
Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, FOCUS, iWay, Omni-Gen, Omni-HealthData, and
WebFOCUS are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation and/or its affiliates.

All other product and company names and marks mentioned in this document are the property
of their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the
readme file for the availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S)
DESCRIBED IN THIS DOCUMENT AT ANY TIME.
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